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 דבר העורכים 

 

קרנים. איצא ל The Matrixהסרט הראשון מטרילוגיית הסרטים ( 31/03/1999שנה ) 20היום, בדיוק לפני 

 שניתןכמה  עד)ההאקינג  תחוםי הראשונים ביצעדהתחלתי את ממש , ו11 בן ייתיההתקופה באותה 

במנועי או  XDCC בבוטי חיפוש קטעי קוד לא מובנים, בשרתים שכוחי אל IRCהתחברות לערוצי לכנות 

ולצפות  nmap פלטי גדקמפולם והרצתם כנ, Astalavista.box.sk ,ecurity.comStormSacketP חיפוש כגון

כלום על  כמעט ולא שמעתי Wargames או, Hackers שהיו אז, כגון יםסרטב צפייה ומלבד. (האקינג - לטוב

 .(רשנים מאוחר יותמספר שמעתי  Sneakers-ו Tron יםעל הסרט) התחום

 "האקינג"או  "האקר" יםהזכיר את המושג לאוכמעט ב זכרוני השיח מסבייטב למ, אך 11רק בן אז הייתי 

שאליו הייתי  QBasic היה חוג הספרבבית  רהקרוב ביותר למגמת סייבהדבר  .("סייבר"שלא נדבר על )

ברות אליו והן מבחינת הנגישות הן מבחינת ההתח) מהיוםוזמין ינטרנט היה הרבה פחות נגיש והארשום, 

המודעות . (למידע הקיים בו, פחות השתמשו בגוגל ויותר במנועי חיפוש שחיפשו מתוך רשימות סטטיות

וד שקמפלנו קקטעי ותם או ים-Firewall-ולא השתמשו במעט כ :אבטחת מידע כמעט ולא הייתה קיימתל

מאוד בתחום ההאקינג, תי תעניינה חולשות פורסמו.האחרי שעדכונים לאותן גם הרבה מאוד זמן עבדו 

וך אך גם מת סצינת האקינג מקומית, סוג של צלחתי להשיג מקבץ טקסטים שהעיד על כך שקיימתהואף 

פשוט לא היה אקינג ה .תי מעטניתן היה לראות שמדובר במ IRC-ערוצי המהשיחות בגם ו הטקסטים

 דיברו עליו.שמשהו 

בהחלט יכול להיות אך )הייתה לי הרגשה שמשהו מעט השתנה לאור,  מטריקס יצא שהסרטאחרי 

על העלילה שלו עם חברים,  ולהתפלסף, מלבד ההנאה בצפייה בסרט .(שמדובר בחוויה אישית בלבד

נכון שזה ) האקר להיות הדמות הראשיתסתם יוצרי הסרט בחרו בנימית שלא הייתה בי ההרגשה הפ

נבעה לכך שהבחירה הרגשתי  .(לא חשבתי על זה לעומקה וכו', אבל כנראה מסתדר אחלה עם כל העליל

איך באמת אף אחד לא הבין ו טכמע (כך לפחות חשבתי)שנים  ןבאות :מאותה הרגשה שאני הרגשתי

נה מה עשיתי אפס הב כמעטשהרצתי פעלו לי, הייתה לי סתומים אותם קטעי קוד כשגם האקרים פועלים. 

, וההרגשה הייתה שיש כאן איזשהו סוג של קסם שבמקרה הצלחתי להחשף להבנה ואיך בדיוק זה קרה

 .לא למה הוא עובדאבל  -של איך לבצע אותו 

, הרבה מהסרט בה הוא חי "המציאות"נחשף לעוד ועוד רבדים של  - הסרטגיבור  - וא, ניהעלילהבמהלך 

 :גהרגשתי כלפי תחום ההאקינהייתה בדיוק זאת . של העולם "מאחורי הקלעים"מתרחש במסדרונות 

, ורק אחרי כדי להבין בדיוק איך משהו עובדמעל פני המציאות ה לקלף שכבה ועוד שכבדורש ר שאתחום 

עוד טפח  חשפו בפני תמיד שיצאו על הסרט הניתוחיםשלל  ."קסמים"צע את אותם ניתן לבההבנה הזו 

אם אלו הרפרנסים השונים המוזכרים בו, אם ההקבלות לכל מני בין זווית חדשה על הסרט, נתנו לי ו

https://web.archive.org/web/19990208003411/http:/astalavista.box.sk/
https://web.archive.org/web/20010721220134/http:/www.packetstormsecurity.com/
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ות קטנות שיוצרי הסרט שתלו פה ושם, כולן תמיד הזכירו אלו סתם בדיחהיו פילוסופיות דתיות שונות ואם 

 לי שיש עוד רובד ועוד שכבה שאפשר לקלף.

, ועוד. ברוח הסרט ם למחשב ולקונסולות אחרותהמשך, משחקיסרטי  שחלפו לאחר מכן יצאו עודשנים ב

, לא שיחקתי בהם אף פעם ולא Gamerיחסית  ילמרות שבילדות שלי היית)התחברתי אליהן חות פ

המשכתי שמרתי אמונים לסרט הראשון.  -נהנתי מסרטי ההמשך ש ולמרות ,(הרגשתי את הצורך לנסות

בסרט הראשון עלילה ה. ינגלהרגיש כך למרות שבסרטי ההמשך יש לא מעט קריצות לתחום ההאק

, והדיאלוגים הרגישו לי אמיתיים יותר, ובכלליות האווירה גם האפקטיםהרגישה לי ממוקדת וסגורה יותר, 

 .טובה יותר הרגישה לי

ית המבט שלי על תחום ו, וגם זו(...שנה 20בכל זאת, עברו ) הייתי רוצה להאמין, התבגרתי רבות מאז,

, אני נושא י כשראיתי לראשונה את הסרטרגש שצץ ב ניצוץ שלאת אותו אך לא מעט.  התבגרהההאקינג 

השנים האחרונות,  20-גם עם כמות הסרטים הרבה שיצא לי לראות ב -לאחור במחשבה ו .עד היום בליבי

 אני חושב שלא ראיתי סרט טוב יותר ממנו.

סתובבים אי שם ברחבי לכל אותם האקרים בודדים שמ, הנוכחי מוקדש לסרט הנפלא הזההגליון 

רית היום יכולים להשיג חומר איכותי בעב 11ילדים בני  ,שבזכותם -ולכל הכותבים שלנו  הסייברספייס

 אינטרנט ב ינות מפוקפקותפמני צריכים להסתובב בכל  אינםו

, יש מי שניצל אותו בצורה נבונה שכולנו בזבזנו את הזמן החודשבזמן  :לתודותנעבר  -איך לא  וכמובן

ה רבה תוד , אזוישב לכתוב מאמר למגזין, כדי שיהיה לכם גם הפעם איך להתחיל החודש על רגל ימין 

תודה רבה , איטקין איילתודה רבה ל, כורסיה יהודהתודה רבה ל, שוסטין רונןתודה רבה ל, דקל כסיףל

 !זינגר גלעדתודה רבה לו צינגיסר אורל

 

 קריאה נעימה,      

  אפיק קסטיאל וניר אדר
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 'א חלק - Ghidra-ל מבוא

 כסיף דקל ורונן שוסטיןמאת 

 

 

 הקדמה

, כלי חינמי רב עוצמה Ghidra-, שחרר את דרקון הNSA-בתחילת החודש, ארגון הביון האמריקאי, ה

כדי לסייע במחקר פנימי. הארגון החליט  NSA-שפותח במשך שנים רבות על ידי חטיבת המחקר של ה

-לשחרר את הכלי כפרויקט קוד פתוח, תחילה בצורה חלקית, אך בעתיד יעלה הקוד בצורה מסודרת ל

Github .הרשמי ויהיה ניתן לבנות אותו מקוד המקור 

שלם, הנתמך בפלטפורמות  Reverse Engineering Framework? הכלי מהווה Ghidraאז מה הוא למעשה 

 Disassembler ,Decompiler ,Assembler ,Graphing ,Scriptingרבות. הכלי כולל בתוכו פיצ'רים כגון 

 'רים נוספים., וגם שלל פיצIDA Pro-בדומה ל

חדשים בקלות,  Processorsומאפשר למשתמשים להוסיף  Instruction Setsהכלי תומך במגוון רחב של 

-ו Javaדבר שכבר קרה, מספר פעמים, מהר מאוד עם שחרור הכלי. הכלי מאפשר סקריפטינג בשפות 

Python  וכמו כן במצבHeadless CLIעצם היותו כתוב ב .-Javaת", נתמך הכלי בכל , שהיא שפה "נייד

 .JVMמערכת הפעלה המאפשרת להריץ 

הכלי אומץ במהרה על ידי הקהילה ונכון לרגע כתיבת המאמר, נכתבו לכלי מגוון רחב של פלאגינים, 

 .נוספים, מאמרים וסרטונים רבים CPUs-תמיכה ב

טיפים כלליים  באופן כללי אלא נסקור את התכונות העיקריות וניתן Reversing-במאמר זה לא נעסוק ב

 לשימוש בכלי, הבה נתחיל.

 

  

https://github.com/NationalSecurityAgency/ghidra/
https://github.com/NationalSecurityAgency/ghidra/
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 הקמת פרויקט חדש

 ופתיחתה יופיע החלון הבא:  Ghidraלאחר התקנת 

 

, לא ניתן IDA-, בשונה מGhidra-, למעשה כל דבר הוא פרויקט בProject Managementחלון זה נקרא 

וכנה בפעם הראשונה חדש. כאשר תפתחו את הת Inputלהתחיל את העבודה רק על ידי טעינת קובץ 

 ותרצו להקים פרויקט חדש, יופיע החלון הבא: 

 

תחילה תצטרכו לבחור האם מדובר בפרויקט משותף. התוכנה מאפשרת עבודה משותפת על פרויקטים 

וסנכרון בין המשתמשים השונים תחת אותו פרויקט באמצעות שרת מרכזי, נבחר ליצור פרויקט רגיל 

 ונמשיך.

 לפרויקט טעינת קבצים חדשים

במסך לאחר מכן תצטרכו לבחור שם לפרויקט ואת המיקום בדיסק בו הוא ישמר. לאחר יצירת הפרויקט 

, ניתן גם לגרור את iאו על ידי קיצור המקשים  Import Fileואז לחיצה על  Fileנטען בינארי חדש באמצעות 
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 Out-of-the-boxטים הבאים נכון לרגע כתיבת המאמר, הכלי תומך בפורמ הקובץ ישירות לתוך החלון.

 )ללא פלאגינים חיצוניים(:

 GZF Input Format 

 Ghidra Data Type Archive Format 

 XML Input Format 

 Common Object File Format (COFF) 

 Dalvik Executable (DEX) 

 Debug Symbols (DBG) 

 Executable and Linking Format (ELF) 

 Java Class File 

 MS Common Object File Format (COFF) 

 Mac OS X Mach-O 

 Module Definition (DEF) 

 New Executable (NE) 

 Portable Executable (PE) 

 Preferred Executable Format (PEF) 

 Program Mapfile (MAP) 

 Relocatble Object Module Format (OMF) 

 Old-style DOS Executable (MZ) 

 Intel Hex 

 Motorola Hex 

 Raw Binary 

 רחב, בעת טעינת קובץ חדש נקבל את המסך הבא:  CPUוגם במגוון ארכיטקטורות 

 

כבר הבינה לבד באיזה קובץ מדובר )במידה וניתן לזיהוי(  ואילו הגדרות להחיל  Ghidra-ניתן לראות ש

, או שצריך איזשהם כוונונים Firmwareמסוג כלשהו, למשל  Rawעליו, אך במידה והנכם טוענים קובץ 

 :Language-פים ניתן לעשות זאת על ידי לחיצה על כפתור שלוש נקודות ליד שדה הנוס
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יציג  הירוקלגבי הקובץ, כגון ארכיטקטורה )ביטול הסימון בעיגול  Ghidraכאן ניתן לכוונן את בחירותיה של 

, סוג ארכיטקטורות נוספות אך לרוב לא תצטרכו לגעת בזה כאשר תתעסקו עם קבצים בעלי פורמט מוכר(

 ( וכדומה.Endiannessקומפיילר, סדר בתים )

 לאחר טעינת הקובץ, התוכנה תציג לנו סקירה מהירה של הקובץ: 

 

, מסך זה הינו CodeBrowser-לחיצה כפולה על הקובץ שנטען או על הדרקון הירוק תפתח את מסך ה

לאחר האנימציה . המסך העיקרי איתו תעבדו בתוכנה ולמעשה משמש מין מסך ראשי לשאר המסכים

 כרגע:  Auto Analysis-המגניבה כמובן, נשאל אם ברצוננו להפעיל את ה

 

 תאפשר לנו לבחור הגדרות נוספות לגבי האנליזה האוטומטית, Ghidraכעת ייפתח חלון נוסף שבו 

 הגדרות אלה לרוב גנריות אך יש כמה אשר מותאמות לארכיטקטורות מסוימות בלבד.
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ואפילו חיפוש של  Symbol Data, ביניהם חיפוש מחרוזות, טעינת Analysis Tools המוןהכלי מגיע עם 

אנו ממליצים לסמן את האופציה הזו לקבלת תוצאה טובה )משופרת( יותר במסך  תמונות ומדיה נוספת.

 שנראה בהמשך:  Decompiler-ה

 

 י:בשלב מאוחר יותר באופן ידני על יד Auto Analysis-ניתן גם להפעיל את ה

Analysis -> Auto-Analysis 

 בהפעלתו, לכל הפחות יתבצעו הדברים הבאים: 

 התחלה ב-Entry Point 

  ביצועDisassembly 

 יצירת פונקציות 

 יצירת רפרנסים 

 יבצע ניתוחים נוספים כגון: Auto Analysis-כפי שתואר לעיל, ע"פ מה שסומן בהגדרות, כלי ה

 ם לקוד או שימוש באופרנדים על מנת לייצר רפרנסיData היכן שהאופרנדים מצביעים 

  יצירתSwitch Statements ו-Function Signatures על בסיס  מידע מ-Decompiler 

  ביצועDemangle ל-Mangled Symbols 

 ים על בסיס סוג הקובץ הטעון ועודניתוחים נוספ 

, כלומר, עדיף יהיה להפעיל עבור קבצים רבים, הניתוח מסוגל להניב תוצאות טובות יותר בגישת "שכבות"

 תחילה ניתוח בסיסי בלבד, ולאחר מכן להריץ אפשרויות ניתוח אחרות באופן ידני.
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 ניתוח בסיסי: 

  יש לכבות כל ניתוח ספקולטיבי או מיוחד, כמו ניתוח המחסנית, בייחוד אם מדובר בקובץ גדול. ניתן

 ץ או פונקציות מסוימות.יהיה להפעיל אפשרויות אלו שוב לאחר מכן, על כלל הקוב

  באופן כללי, על מנת שניתן יהיה להבחין ביןCode  לביןData עדיף להשאיר את ה-Analyzers  הבאים

 .Reference Analyzers ,Data Analyzers ,Function Analyzersדלוקים: 

 ניתוח המשכי:

 ניתן להפעיל את ה-Auto Analysis אופציה בנפרד על ידי  מחדש עם אפשרויות אחרות או להפעיל כל

 . ניתוחים נפוצים מומלצים:One-Shotואז  Analysisלחיצה על 

o Decompiler Parameter ID 

o Decompiler Switch Analysis 

o Stack Analyzers 

o Etc 

 העבודה סביבת

 

. רוב הממשקים הויזואלים CodeBrowser, שמו של חלון זה נקרא Ghidraכך נראה החלון הראשי של 

, מנהל Listing ,Decompiler ,Graph-בתוך חלון זה, למשל: התפריטים הראשיים, חלונות הקיימים 

הממשק מחולק  ועוד. רוב עבודת הניתוח תתבצע תחת חלון זה. Hexהטיפוסים, חיפוש מחרוזות, עורך 

ד לחלונות שאותם שניתן להזיז ולשנות. במהלך המאמר נסקור את הפיצ'רים הקיימים במערכת, נבין כיצ

להשתמש בהם ונחלוק טיפים אשר ישפרו את חווית השימוש בתוכנה ואופן העבודה איתה. סביבת 

העבודה עמוסה בפיצ'רים ומכל טוב, ומפאת זאת לא נוכל לסקור את כולם אך נדבר על הדברים העיקריים 

 והשימושיים.
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 Listing-ה חלון

 Disassembly, Dataה לו הוא מכיל ניתוח ובדומ Flatבמצב  IDA View-A-חלון זה הוא למעשה המקביל ל

תאפשר התאמה אישית       Edit   -ואפילו דברים נוספים )בין היתר, אף הצגת מדיה(. לחיצה על כפתור ה

 של השדות בחלון:

 

 :Add Fieldניתן להוסיף שדות נוספים על ידי לחיצה ימנית על משטח העורך ולחיצה על 
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כללי של מפת  Overview-תצוגה ויזואלית של האנטרופיה בקובץ הנוכחי ו מאפשר לקבל Listing-חלון ה

 :IDA-הקובץ בדומה לפס העליון ב

 

הכלי מאפשר לייצר טבלאות כמעט מכל אלמנט בתוכנה, על מנת להפעיל את הפיצ'ר סמנו את האלמנטים 

 הרצויים ואז לחצו על:

Select -> Create Table From Selection 

 להוסיף/להסיר עמודות כמו בכל טבלה בתוכנה, כך זה נראה:  וכמובן שניתן
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או  Labels לאחר טעינת המידע הרצוי לטבלה ניתן לבצע עליה חיתוכים מתקדמים. על מנת "לקפוץ" אל

  :IDA-' בדומה לGכתובות ניתן ללחוץ על המקש '

 

 את כל קיצורי המקשים ניתן לשנות בנתיב ההגדרות הבא:

Edit -> Tool Options -> Key Bindings 

 ':L, משתנה, או כל דבר אחר שאפשר לתת לו שם, לחצו על המקש 'Labelכדי לתת שם לפונקציה, 

 

 ניתן להשתמש בעכבר על ידי לחיצה ימנית על האובייקט הרצוי: Cross Referencesעל מנת לחפש 
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 :CTRL + SHIFT + Fאו על ידי קיצור במקלדת 

 

הוא שהתוכנה מפרסרת באופן אוטומטי את הפורמט  Listing-זכיר בהקשר של חלון הדבר נוסף ששווה לה

 :Listing-בחלון ה Headers-של הקובץ שנטען ומציגה את ה

 

 דבר שבהחלט יכול להיות שימושי.
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במידה ואתם לא סגורים על פקודת מעבד מסוימת או צריכים תזכורת, תוכלו לסמן אותה וללחוץ על 

Instruction Info: 

 

 :מיד ייפתח החלון החביב הבא אשר יציג פירוט שימושי מאוד אודות הפקודה
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ובחלונות נוספים על ידי לחיצה ימנית בעכבר על הפקודה  Listing-ניתן לערוך פקודות מעבד גם בחלון ה

  (:CTRL + SHIFT + G)או בקיצור המקשים  Patch Instruction-הרצויה ובחירה ב

 

על  Hexeditorכרצוננו, כמו כן ניתן לערוך חלקים במודול גם באמצעות  Instruction-רוך את הכעת נוכל לע

   :ידי לחיצה על הכפתור

 

בתפריט הלחצן הימני תציג בפניכם את החלון  Convertולחיצה על  Listing-סימון ערך כלשהו בחלון ה

 הבא:

 

 .Listing-ן הלחיצה על אחת מן האופציות הנ"ל תחיל את השינוי בחלו
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כאשר  Thumbבמצב  Disassemblyקיימים דברים פחות טריוויאלים בתוכנה כמו למשל איך לאכוף 

 "Processor Disassembly Options"-. על מנת לבצע פעולה זו יש לבחור בARMמתעסקים עם קבצי 

 בתפריט הלחצן הימני ואז להחיל את השינוי הבא:

 

, רצוי להשתמש Ghidra-חצן הימני מלא בפיצ'רים שימושיים. ככלל בכפי שוודאי הבחנתם, תפריט הל

 בלחצן הימני כאשר אתם מחפשים משהו, התשובה עשויה להיות שם. 

 

 Graph-ה חלון

ואז לחיצה  Windowאו בתפריט       החלון אינו פעיל כברירת מחדל, ניתן לפתוח אותו על ידי לחיצה על 

בנפרד, אך ניתן להצמיד אותו לחלון הראשי. יש לגרור את החלון  . החלון יפתחFunction Graphעל 

 הפנימי )עם הפס הכחול( ולא את המעטפת: 
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. כפי שהוסבר לעיל, ניתן לערוך גם Graph-דבר נוסף שלא קיים כברירת מחדל הינו הצגת הערות בחלון ה

 לות הבאות: , נלחץ על הכפתור ונבצע את הפעו      את חלון הגרף באמצעות הכפתור 

 

 הערות ניתן להוסיף על ידי לחיצה ימנית על השטח בו ברצונכם להוסיף הערה, ואז על סוג ההערה הרצוי:

 

להערות על  Symbolכעת יש לבחור את סוג ההערה הרצוי, פיצ'ר חשוב נוסף בעניין זה הוא שניתן להוסיף 

 ידי:
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על מנת לאפשר "מעבר נוח"  ית גם בהערה., יתבצע עדכון באופן אוטומטLabel-כאשר ישתנה שם ה

 , ניתן לשנות את ההגדרות הבאות בנתיב:IDAלמשתמשי 

Edit -> Tool Options -> Function Graph 

 

כפי שניתן להסיק לבד, שינוי ההגדרות הנ"ל יאפשר גלילה בגרף באמצעות הגלגלת בעכבר והגרף ייפתח 

 כברירת מחדל. Zoomed inבמצב 

למשתנה, קבוע, אוגר או פקודה כלשהו יש ללחוץ על הלחצן האמצעי  Highlightנת לבצע כמו כן, על מ

על ידי ביצוע  IDA-like behavior(, ניתן לשנות גם הגדרה זו על מנת לאפשר Scrolling buttonבעכבר )

 השינוי הבא:

Edit -> Tool Options -> Listing Fields -> Cursor Text Highlight 
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 נה תמרקר לנו מופעים נוספים של האובייקט המסומן:כעת התוכ

 

תוצג  Listing-, כאשר תעמדו עם העכבר על אובייקט שמוביל למיקום אחר בגרף או בIDA-בדומה ל

 בפניכם תצוגה מקדימה שנראת כך:

 

כברירת מחדל, במצב הגרף יש הגבלה לאורך הקוד המוצג, ניתן להגדיל אותו באופן הבא: לחיצה על 

 ולאחר מכן לגרור את קצוות השדה לאורך הרצוי, כפי שמופיע בתמונה:        ורךהע
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מסוימים בצבעים, ניתן לעשות זאת על ידי לחיצה על  Code blocksעוד פיצ'ר שימושי בגרף הוא צביעת 

  :          הכפתור

 

באופן  קוד נצבעים גם שם.והחלקים הרלוונטים ב Listing-כפי שניתן לראות, הגרף מסתנכן עם חלון ה

 Listing ,Decompilerכללי, התוכנה שומרת על סנכרון של הסימון הנוכחי בין שלושת החלונות העיקריים: 

 . ניתן להרחיב זאת לחלונות נוספים כפי שנראה בהמשך.Graph-וכמובן ה

ל מנת למנוע "טיולים" מאפשר לכם ליצור עותק של החלון הנוכחי ע       : שנראה כך Snapshot-כפתור ה

מיותרים בניווט בין מיקומים בקובץ, פיצ'ר זה הינו רלוונטי לכלל חלונות התוכנה שמציגים קוד שנראה 

    בהמשך. במידה ותרצו לנווט בהיסטוריית המיקומים, תוכלו לעשות זאת על ידי שימוש בכפתורים הללו  

 .ALT + RIGHT/LEFT ARROWדי קיצורי המקשים עליון של המסך או על י-בצד השמאלי.               

( חדש הוא בעצם יהיה מנותק מהחלונות האחרים מבחינת הסנכרון Snapshotכשתיצרו חלון העתק )

 :שהתוכנה מבצעת
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 Decompiler-ה חלון

תהליך דיקומפיליצה של קוד הוא תהליך קשה ומסורבל. אך כאשר הוא עובד כראוי, תועלתו מאפשרת 

יודע להמיר  Ghidraבודת הניתוח ולאפשר מיקוד בדברים אחרים. כיום הדיקומפיילר של להאיץ את ע

 .IDAשל  HexRaysונותן פייט רציני מול  C-בצורה טובה קוד אסמבלי ל

כפי שצוין, הסנכרון בין החלונות השונים, הוא מעולה ורוב קיצורי הדרך הקיימים, תקפים גם בחלון זה. 

ולת זיהוי הטיפוסים לוקה בחסר, לכן, על מנת לשנות את טיפוס המשתנה נלחץ חשוב לציין שבשלב זה יכ

. לאחר מכן ייפתח לנו CTRL + Lאו לחלופין בעזרת קיצור המקשים  Retype Variableעל הלחצן הימני ואז 

 החלון הבא ושם נוכל לבחור את הטיפוס הרצוי:

 

קציות, כך נוכל לקבל קוד ברור, נכון ומובן. כך ככל שנדייק יותר בבחירת טיפוסי המשתנים וחתימת הפונ

 נראה חלון עריכת חתימת הפונקציה: 
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 :Decompiler-נסתכל על התפריט העליון בחלון ה

 

 .בצהוב המוקף הכפתור על נלחץ, הניתוח את מחדש לבצע Decompiler-מה לבקש כדי .1

 .בכחול המוקף הכתפור על נלחץ לקובץ הקוד את לייצא כדי .2

 שהוסבר כפי, סגול בצבע המוקף הכתפור על נלחץ, חדש בעותק החלונות בין הסנכרון את ללבט כדי .3

 .Graph-ה בחלון כבר

עוד פיצ'ר מעניין ושימושי מאוד הינו זיהוי מבנים באופן אוטומטי. במידה ואנו משערים שאחד מהמשתנים 

מטי. כאשר נפעיל אותו על לייצר מבנה חדש באופן אוטו Decompiler-בקוד הוא מבנה, נוכל לבקש מה

על פי הגישות אליו בקוד ותייצר מבנה  Struct Members-אובייקט מסוים, התוכנה תנסה לאבחן את ה

 Auto Create-מתאים. ניתן להשתמש באפשרות זו על ידי לחיצה ימנית בעכבר על המשתנה הרצוי ואז ב

Structure  + ]" או דרך קיצור הדרךCTRL." 

עלול לקחת זמן רב,  Initial Auto Analysis-ים עם פונקציות גדולות, לעיתים תהליך הכאשר אנו מתמודד

 שהוגדר, ובכך לאפשר את התקדמות הניתוח. Time Out-באפשרותינו להגדיל את ה

Edit -> Tool Options -> Decompiler 

 

נו את הסגמנטים : סמFirmware: כאשר מנתחים קבצי Decompiler-טיפ נוסף שמשפר פלאים את פלט ה

, כך תדע התוכנה שמדובר במידע קבוע והקוד ייראה טוב וקריא יותר, Read only-כ Flash memory-של ה

 :על מנת לשנות את ההרשאות בסגמטנים יש להכנס ל

Window -> Memory Map  

 .CodeBrowser-בחלון ה         או פשוט ללחוץ על הקיצור דרך
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 שינוי ההרשאות: לדוגמה, כך זה נראה לפני

 

 לאחר שינוי ההרשאות:
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 Symbols Tree-ה חלון

חלון זה מאפשר לנו לבחון את המידע שהתוכנה זיהתה לאחר תהליך האנליזה, לרוב מידע זה כולל 

. כמו כן, גם ניתן לבצע שינויים על אותם סוגי מידע מתוך Exports-ו Importsמחלקות, לייבלים, פונקציות, 

 חלון זה.

 :kernel32.dll-ניתן לראות את הפונקציות שהתוכנית מיבאת מ תמונה הבאהב

 

לחיצה על פריט בתוך החלון תנווט אתכם בשאר החלונות לאותה פונקציה. אם אינכם מרוצים מחתימת 

, בדומה למה Edit Function Signature-פונקציה מסוימת שיובאה תוכלו לערוך אותה על ידי לחיצה ימנית ו

 קודם: שעשינו
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)כפי שכבר צוין, ניתן  Imported File-ל Symbols Tree-פיצ'ר מעניין נוסף הוא היכולת לחבר פריט מתוך ה

( כך שיהיה חיבור בין הכתובות, לדוגמה, אנו יודעים Code Browser-לטעון יותר מקובץ אחד לתוך ה

לטעון את הקובץ ואז להכנס  , נוכלKERNEL32.DLL-מגיעה מ IsProcessorFeaturePresentשהפונקציה 

ולאחר מכן  Edit External Locationוללחוץ  Symbols Tree-לתפריט הלחצן הימני של הפונקציה בחלון ה

 : Edit Pathללחוץ 
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 Data Type Manager-ה חלון

התחתון -החלון מאפשר ניהול של טיפוסים והגדרות פונקציות, כברירת מחדל ממוקם החלון בצד השמאלי

 המסך, כך הוא נראה: של

 

 בחלון זה ישנם כמה סוגי תיקיות:

 תיקיית ה-BuiltInTypes  אשר מכילה את טיפוסי ברירת מחדל שמפתחיGhidra הוסיפו 

 תיקיית ה-Module ונקציות שכרגע בשימוש או שהוספנושאנו מנתחים, תכיל טיפוסים והגדרות פ 

  אוטומטית מקובץ בפורמט תיקיית הטיפוסים והגדרות פונקציות שהתוכנה טענהGDT שאותו היא ,

של  TIL-והינו המקביל ל Ghidra Data Typeפורמט זה נקרא . בחרה לפי סוג הקובץ שאנחנו מנתחים

IDA .ככל הנראה, על בסיס השערות, ה-NSA עדיין לא פרסמו את כל קבצי ה-GDT  כך שיהיה אפשר

 .לבצע בעזרתם ניתוח נוח

ולאחר מכן נבחר בטיפוס  New-שלנו, נבחר ב Module-לחץ על תיקיית העל מנת ליצור טיפוס חדש, נ

 :Structureרצוי. לדוגמה, כך יוצרים מבנה חדש מסוג 
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 לאחר מכן יפתח לנו החלון הבא:

 

עלינו לבחור שם למבנה החדש, באפשרותינו לתת לו גם תיאור. בנוסף, אם אנו יודעים את הגודל המבנה, 

אחרת, נצטרך ללחוץ על סימן הפלוס למעלה כדי להוסיף שדה חדש. כאשר נגדיר  נוכל להגדיר גם אותו,

 גודל כללי למבנה, העורך יצור עבורנו אוטומטית ערכים ע"פ הגודל שסופק:
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לפי  Offests-, העורך אוטומטית יתאים את הDataType-כאשר נגדיר את סוג הטיפוס על ידי הגדרת ה

 הגודל:

 

 (:Offsets-)שימו לב ל DataType-ת הכך זה נראה לאחר בחיר

 

 ניגש ל: Header, כדי לייבא קובץ C Headersהכלי מציע גם פיצ'רים נוספים כגון ייצוא וייבוא של קבצי 

File -> Parse C Source  

 .Export C Headerשלנו, ולאחר מכן  Module-יצוא חתימות וטיפוסים מתאפשר על ידי לחיצה ימנית על ה
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 Memory Map-ה חלון

, גודלן Sections-כחלק מתהליך המחקר, חשוב לדעת כיצד ממופה הזיכרון בתוכנית, מהן ההרשאות ב

 :ועוד. נוכל לעשות זאת בחלון זה

Window -> Memory Map 

 

  כדי לבצעRebase  לתוכנית, נלחץ על הכפתור המוקף בסגול )בית(, שם נוכל לציין את הכתובת

 החדשה.

 זיכרון חדש, נלחץ על הכפתור המוקף בירוק )+( ונוכל לציין את: כדי להוסיף בלוק 

 שם הבלוק ○

 כתובת התחלתית ○

 גודל ○

 הרשאות ○

 ועוד ○

 .כדי לפצל בלוק זיכרון קיים, נלחץ על הכפתור המסומן בכחול 

 כדי לשנות כתובת התחלה או סוף של בלוק קיים, נלחץ על הכפתורים המוקפים בכתום 

 וכדי למחוק בלוק זכרון נלחץ ( על הכפתור המוקף באדוםX.) 
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 נוספות תכונות

 חיפוש

 Searchמנוע חיפוש מפואר, כעת נציג את תכונותיו. ראשית כדי לגשת לחיפוש נלחץ על  Ghidra-ל

 בתפריט העליון ונבחר באופציה הרצויה. להלן סוגי החיפוש הקיימים וחלק מקיצורי הדרך הקשורים בהם:

 

  חיפושProgram Text - חיפוש של כל טקסט בחלונות שנוסף על ידי  מאפשרGhidra  או על ידי

 , רפרנסים, קוד ועוד.labelsהמשתמש, כולל: שדות, הערות, 

 ניתן להפעיל את החיפוש על כלל התוכנית או על חלקים שנבחרו. בחירה ב-Search All Instances 

 יוצרת טבלה עם כל תוצאות החיפוש.

  חיפושMemory -  לחפש סט של בתים בכלל התוכנית או בחלקים שנבחרו, ניתן מאפשר למשתמש

. גם בסוג חיפוש זה ניתן לייצר RegEx-ועוד. ניתן גם להשתמש ב Hex ,ASCII ,Unicodeלחפש בייצוג 

 טבלה מתוצאות החיפוש.

  חיפושStrings -  מאפשר חיפוש של מחרוזות בכל התוכנית או בחלקים נבחרים מסוגASCII ,Unicode 

 Labels. בסוג חיפוש זה התוצאות מגיעות כברירת מחדל בטבלה, בה ניתן לחפש ולייצר Pascal-ו

 מתוך חלון התוצאות.

  חיפושDirect References -  מאפשר למשתמש לחפש מקומות בתוכנית בהם בתים מהווים רפרנס

 (  למיקום הנוכחי בקוד או למספר כתובות שנבחרו.Call instruction)למשל 

  חיפושAddress Tables -  פיצ'ר מעניין, מאפשר לחפש טבלאות של כתובות, ניתן לציין גודל מינימלי

 וכמה בתים לדלג בין כל כתובת. alignmentשל הממצאים, 

  חיפושInstructions -  מאפשר למשתמשים לחפשinstructions  לפיPattern  מסוים, ניתן לציין אם

עשה ממירה את בקשת החיפוש שלנו לבתים ומבצעת חיפוש לכלול או לא אופרנדים. האופציה הזו למ

memory .רגיל 

  חיפושScalars - .מאפשר למשתמש לחפש ערכים סקלרים. ניתן לציין טווח ערכים או ערך ספציפי 
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 סקריפטינג

עוצמתי ביותר ומתועד היטב. ממשק מנהל  Scriptingמציעה ממשק  Ghidra, גם IDA-בדומה ל

. ניתן לגשת אליו Scripting-( למעשה עוטף את כל הפיצ'רים הקשורים בScript Managerהסקריפטים )

 באמצעות: 

Window -> Script Manager 

 

 Java-סקריפטים הכתובים רובם ב 250-כך נראה הממשק, כפי שניתן לראות, התוכנה מגיעה עם קרוב ל

 .Python-וחלקם ב

בעית לכתיבת פלאגינים וסקריפטים, אך ניתן גם , זוהי השפה הטJava-מכיוון שרוב התוכנה כתובה ב

 .Python-לכתוב סקריפטים ב

על מנת להריץ ,      בממשק זה ניתן להגדיר נתיבים חדשים לחיפוש סקריפטים באמצעות הכפתור

 Play Again-ממנו יש את כפתור ה, Play-סקריפט אפשר ללחוץ עליו פעמיים או ללחוץ על כפתור ה

מאפשר למשתמש להגדיר קיצור מקשים       הסקריפט האחרון שוב. כפתור המפתחשמאפשר להריץ את 

 לסקריפט המסומן.
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. על מנת שיהיה Eclipseניתן לערוך סקריפטים באמצעות עורך הטקסט הפשוט של הממשק או באמצעות 

  :שנמצא בנתיב GhidraDEVיש להתקין את התוסף  Eclipse-ניתן לכתוב סקריפטים ב

ghidra_9.0\Extensions\Eclipse\GhidraDev 

מאפשרת אוטומציה של התהליך הנ"ל ותתקין לכם לבד את ,     לחיצה על הכפתור עם הסמל

GhidraDEVבמידה וכבר לא הותקן בעבר ובהינתן ו ,-Eclipse .מותקנת על המכונה 

קריפטים ממשק העבודה הרבה יותר נוח, ניתן לדבג את הס Eclipse-מותקנת ב GhidraDEV-לאחר ש

 יחל לפעול. Ghidraשל  API-( עבור הEclipse-)בגרסתו ב IntelliSenseעצמה, וגם  Ghidraשלנו ואת 

שנמצאת בתיקיית התקנה  Ghidraשל  API-כפי שהוזכר, קיימת דוקומנטציה מפורטת מאוד לגבי כל ה

 שלכם.

 אותה אנו מתחזקים ומתקנים.  ,כאןכמו כן העלנו גרסה מקוונת לדוקומנטציה שניתן למצוא 

אם ברצונכם להחיל את התיקונים בגרסה שלכם תוכלו להחיל את התלאי הבא וכמו כן לעקוב על מנת 

 לקבל תיקונים נוספים:

 https://github.com/NationalSecurityAgency/ghidra/issues/129 

 Featuresבנוסף, אם מסיבה כלשהי אתם נזקקים להציץ בקוד המקור, תוכלו למצוא אותו בכל תיקיית 

 : feature-src.zipבשם  Zipבקובץ 

 

למעשה, כל התוכנה מורכבת מפלאגינים, כל פלאגין מספק פונקציונליות מסוימת. פלאגינים מתקשרים 

הינו אוסף של פלאגינים וההגדרות שלהם,  Toolשבתוכו הם מעוגנים.  Toolם ובין עצמם בתוך אותו בינ

https://ghidra.re/docs/
https://github.com/NationalSecurityAgency/ghidra/issues/129
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מוגדרים מראש שניתן להתאימם לדרישות המשתמש. ניתן להוסיף  Toolsהתוכנה מגיעה עם מספר 

 ולהסיר פלאגינים מבלי לפתוח מחדש את התוכנה וכמובן ניתן לכתוב פלאגינים חדשים. 

-One, סקריפטים נועדו יותר לפעולות מסוגCodeBrowser-אגינים, שהינם גלוים וקבועים בבשונה מפל

Shotהודעות מסקריפטים יוצגו בחלון ה .-Console  שפתוח באופן כברירת מחדל בתחתית המסך, אך

מזהה איזשהי  Consoleולתקשר עם המשתמש. במידה וה  GUIסקריפטים יכולים גם להשתמש במחלקות 

 הוא יהפוך אותם ללחיצים על מנת להקל עליכם. Labelו כתובת א

 :Ghidra-של סקריפט ב Templateכך נראה 

 

 ".runשלנו בסקריפט נמצא בפונקציה " "entrypoint"-ה ,GhidraScript-הסקריפט צריך לרשת מ

 מספר אובייקטים שימושיים:

 currentProgram - הנוכחית התוכנית את שמתאר מופע  

 currentAddress - בתוכנית הנוכחי המיקום של הכתובת  

 currentSelection - הסקריפט הרצת בעת שנבחרו החלקים את שמייצג מופע  

 currentHighlight - כרגע שמסומן האלמנט את מייצג  

וכל  Analysisכלל  GUI, במצב זה לא מוצג Headless Analyzerיכולה לפעול במצב  Ghidra-חשוב לציין ש

Tool  בשלא תלוי-GUI  .יכול לפעול במצב זה 
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 ביטול מדיניות

לביטול  CTRL + Zבקיצורי מקשים  Undo/Redo-אחד הפיצ'רים החזקים ביותר של בתוכנה הינו תמיכה ב

 להחזרת הפעולה. תסמכו עלינו, זה יחסוך לכם הרבה סבל. CTRL + SHIFT + Zהפעולה ובקיצור 

 

ניתנת לביטול  -ים, כל פעולה, לא משנה כמה קטנה או גדולה וחלונות נוספים דומ Code Browser-בתוך ה

. העבירו את העכבר מעל החצים כדי לראות לאיזו פעולה           ( על ידי החצים Undo/Redoאו חזרה )

 הנכם מבצעים ביטול או החזרה:

 

קט רצוי ולחיצה מקיפים מאוד אשר מסבירים ומפרטים כל פעולה בתוכנה, סימון אוביי Helpקיימים עמודי 

לרוב תפתח את חלוןו העזרה הרלוונטי, ולעיתים תדרוש קצת חיפוש ידני. קיצורים שימושיים  F1על 

 של התוכנה. Cheat Sheet-נוספים ניתן למצוא בעותק האונליין ל

 של התקנת התוכנה.קובץ זה וקבצים נוספים, קיימים גם בעותק המקומי 

 

  

http://ghidra.re/CheatSheet.html
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 חלק מעבר

וכתבו פלאגין שמאפשר לייצא  Ghidra-ל IDA-מ מנת לאפשר מעבר-מפתחי התוכנה דאגו לנו עם כלים על

IDB  קיים מתוךIDA ולטעון אותו ל-Ghidra טעינת  -. כמו כן קיימת גם הגרסה ההפוכהProgress קיים מ-

Ghidra  אלIDA. :הפלאגין נמצא בנתיב 

\ghidra_9.0\Extensions\IDAPro 

, לאחר שתטענו את הפלאגין xml_exporter.pyתצטרכו להשתמש בפלאגין  IDAעל מנת לבצע ייצוא מתוך 

 ותפעילו אותו יופיע בפניכם החלון הבא:  IDA-ל

 

 .התוכנה לתוך xml-ה קובץ את לטעון תוכלו מכן לאחר, לייצא ברצונכם בדיוק מידע איזה לבחור תוכלו כאן
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 םסיכו

במאמר זה נגענו רק בקצה הקרחון. קיימים עוד שלל פיצ'רים שבהם לא עסקנו, אך אפשר להגדיר את 

 בחינם, קשה להישאר אדישים.  -כהתאהבות מיידית, כלי כה רב עוצמה  Ghidraההיכרות עם 

יפה רבות בכבוד רב אך עדיין יש לאן לשאוף וא REתוכל לעמוד במשימות  Ghidra-אפשר לומר בביטחון ש

)או לפחות עדיין לא שוחררה לציבור(. בשביל זה  Debugging-להשתפר. למשל, לא קיימת כרגע תמיכה ב

אנחנו פה, הקהילה, על מנת שהפרויקט "יישאר באוויר" ולא ייזנח, נצטרך להשקיע זמן ומאמץ על מנת 

 לתחזק אותו, לפתור באגים, לכתוב פיצ'רים ופלאגינים חדשים ועוד.

-רעש גדול, ובצדק. אחד הסימנים הכי גדולים לכך הינו שחרור ה Ghidraרה עשתה מיד עם שחרו

Debugger  בגרסה החינמית שלIDA וכמובן התוכנית למוסדות לימודיים )אך עם מגבלות רבות(. הנושא ,

.  נכון לרגע אך אנו חושבים שכן  Ghidraשנוי במחלוקת, האם שני הצעדים האלו נגרמו עקב שחרור 

של הפרויקט וחלקם כבר תוקנו על ידי הקהילה  Github-ב Issues 250-המאמר כבר נפתחו קרוב ל כתיבת

הכוללת שלל  9.0.1, הקהילה בהחלט נכנסה לזה חזק. בנוסף, יצאה גרסה NSA-עצמה, ללא עזרה מ

 תיקונים ושיפורים.

מתפרסמים על ידי הקהילה בנוסף לכך אנו רואים כל יום מדריכים חדשים, סרטונים ביוטיוב ופלאגינים ש

שם נדאג לפרסם , GHIDRA_RE@ :ההולכת ומתגבשת, אתם מוזמנים לבקר בעמוד הטוויטר שלנו

 עדכונים, פיצ'רים, טיפים ופלאגינים חדשים. 

. הבאוהנכם מוזמנים להצטרף בלינק  Matrix-הוקמה פלטפורמה פעילה לשיח סביב הפרויקט בטלגרם וב

כך שיהיו ניגשים ברשת ומכל  הבאכמו כן, אנו משתדלים לרכז את החומרים הקשורים לפרויקט באתר 

 מקום בנוחות.

 

 הכותבים על

  טוויטרעובד כחוקר אבטחת מידע עצמאי, לכל פניה או שאלה ניתן לפנות ב -כסיף דקל. 

 בחברת מידע אבטחת כחוקר עובד - שוסטין רונן Check Point ,לפנות ניתן שאלה או פניה לכל 

 .טוויטרב

 
 ביבליוגרפיה

[1] http://ghidra.re/ghidra_docs/api/ 

[2] https://ghidra.re/online-courses/ 

[3] https://twitter.com/GHIDRA_RE 

[4] https://twitter.com/ghidraninja/status/1103637622465986560 

[5] Credit to Shaked Reiner for the undo sticker design 

http://ghidra.re/chat/
https://ghidra.re/
https://twitter.com/kasifdekel
https://twitter.com/ronenshh
http://ghidra.re/ghidra_docs/api/
https://ghidra.re/online-courses/
https://twitter.com/GHIDRA_RE
https://twitter.com/ghidraninja/status/1103637622465986560
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 קונטיינרים שני בין חשאי תקשורת ערוץ יצירת

 יהודה כורסיהמאת 

 

 הקדמה

בשנים האחרונות אנו שומעים עוד ועוד על מקרי פריצה לרשתות והדלפת מאגרי מידע עצומים בגודלם 

 רשומות אינסוףבפברואר, ועוד  רשומות מיליון 700 כמעטבינואר השנה, עוד  רשומות מיליארד 2.2)

בשדה מסוים זה החלק הקל,  SQL Injectionבמהלך השנים האחרונות(, במקרים כאלה, נראה שלמצוא 

נשמעת כמו  -טחת מבלי שירגישו מרשת מאוב 800GBבעוד שהמשימה של להדליף מאגר ששוקל מעל 

 משימה בלתי אפשרית.

היא סוג של מתקפה אשר מאפשרת לתוקף להעביר מידע  Covert Channel"בתחום אבטחת המחשבים, 

בין שני תהליכים אשר אינם אמורים להיות מסוגלים לתקשר ביניהם על פי מדיניות האבטחה של 

 (.מויקיפדיההמערכת" )תרגום חופשי 

אם תרצו, ושימוש בהם כחלק ממתקפה כוללת עשוי להקשות  -ערוצי דלף  -מציאת ערוצים סמויים, או 

מאוד על איתור התוקף מאחר וערוצים אלו יהיו בדרך כלל מחוץ ליכולות הניטור של מערך ההגנה של 

 המערכת/רשת.

ובמסגרתו, מצאתי דרך להעביר  - Dockerניכם את התוצאות של מחקר שביצעתי על במאמר זה אציג בפ

 מידע בין שני קונטיינרים למרות שהוגדרו כך שלא יוכלו לתקשר ביניהם. 

של יגאל אלפנט ותומר זית העוסק בנדבך אבטחה  המאמראך לפני שנמשיך, אני ממליץ מאוד לקרוא את 

וכיצד הוא  Dockerבעיקר את ההקדמה המעולה שלהם שמסבירה בצורה טובה מה זה  Docker-נוסף ב

 בנוי.

 

  

https://www.wired.com/story/collection-leak-usernames-passwords-billions
https://www.wired.com/story/collection-leak-usernames-passwords-billions
https://www.wired.com/story/collection-leak-usernames-passwords-billions
https://www.wired.com/story/collection-leak-usernames-passwords-billions
https://www.wired.com/story/collection-leak-usernames-passwords-billions
https://www.wired.com/story/collection-leak-usernames-passwords-billions
https://www.itgovernance.co.uk/blog/list-of-data-breaches-and-cyber-attacks-in-february-2019-692853046-records-leaked
https://www.itgovernance.co.uk/blog/list-of-data-breaches-and-cyber-attacks-in-february-2019-692853046-records-leaked
https://www.itgovernance.co.uk/blog/list-of-data-breaches-and-cyber-attacks-in-february-2019-692853046-records-leaked
https://www.itgovernance.co.uk/blog/list-of-data-breaches-and-cyber-attacks-in-february-2019-692853046-records-leaked
https://www.itgovernance.co.uk/blog/list-of-data-breaches-and-cyber-attacks-in-february-2019-692853046-records-leaked
https://www.itgovernance.co.uk/blog/list-of-data-breaches-and-cyber-attacks-in-february-2019-692853046-records-leaked
https://www.itgovernance.co.uk/blog/list-of-data-breaches-and-cyber-attacks-in-february-2019-692853046-records-leaked
https://www.itgovernance.co.uk/blog/list-of-data-breaches-and-cyber-attacks-in-february-2019-692853046-records-leaked
https://haveibeenpwned.com/
https://haveibeenpwned.com/
https://haveibeenpwned.com/
https://haveibeenpwned.com/
https://haveibeenpwned.com/
https://en.wikipedia.org/wiki/Covert_channel
https://www.digitalwhisper.co.il/files/Zines/0x55/DW85-2-DockerSec.pdf
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 Dockerהסבר קצר על 

לא ארחיב פה על הנושא, מפני שאני מניח שאתם מכירים את התחום או שכבר קראתם את ההקדמה 

 של יגאל אלפנט ותומר זית )ובעיקר כי הם כבר כתבו עליו בצורה מעולה(, אך ממש על רגל אחת:למאמר 

Docker  בצורה מבודלת,  -מאפשר לנו להריץ תהליכים רגילים של מערכת ההפעלה בתוך קונטיינרים

ו, כלומר באופן שבו התהליך יכיר אך רק את הסביבה הקשורה אליו. לדוגמא רק את המערכת קבצים של

 RAMרק את התהליכים שהוא יצר וכדומה וכן לאפשר הגבלה של משאבים לאותו תהליך, כגון הגבלה של 

 וכדומה. CPUהגבלה של כמות 

Docker עושה זאת באמצעות שימוש במודולים הקיימים כבר ב-Linux כדוגמת 

Namespace, UnionFS ,Cgroups ,ו-LXC.  בנוסף, מנגנון זה מאפשר להריץ סביבות באופן סימולטני ונפרד

 אחד. Hostעל גבי 

המעולה של אחד  ההרצאהשרוצה באמת להבין את הנושא לעומק אני ממליץ בחום רב לראות גם את  למי

 .Dockerמהאנשים שכתבו את 

 בכך שהוא יודע להפריד בין Dockerהנקודה שחשוב לי להעביר לכם בחלק זה היא שאנשים סומכים על 

תהליכים בצורה הדוקה. ואם הרצנו שני תהליכים בקונטיינרים אשר קונפגו להיות נפרדים וחסרי יכולת 

 אז אין שום סיבה או דרך שהם יוכלו לעשות זאת. -לתקשר אחד עם השני 

 

 הסבר על המתקפה

תו המתקפה שנספר עליה כעת, מאפשרת לתוקף בעל היכולת להריץ קוד בשני קונטיינרים הרצים על או

Host להצליח להעביר ביניהם מידע בצורה חופשית גם אם הם קונפגו כך שלא תהיה ביניהם שום ,

 תקשורת.

נאלץ לחשוב  -הקונטיינרים קונפגו כך שהם לא יוכלו לדבר ביניהם באופן ישיר, ולכן על מנת לעשות זאת 

 על שיטה עקיפה לעשות זאת.

 :Flag-לצורך ההדגמה נניח והקונטיינרים הוגדרו עם ה

--network none 

 .Loopbackשבעצם משאיר את הקונטיינר רק עם כרטיס רשת לביצוע 

 

https://en.wikipedia.org/wiki/Linux_namespaces
https://en.wikipedia.org/wiki/Linux_namespaces
https://en.wikipedia.org/wiki/UnionFS
https://en.wikipedia.org/wiki/Cgroups
https://linuxcontainers.org/
https://www.youtube.com/watch?v=sK5i-N34im8
https://docs.docker.com/network/none/
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 .Dockerאת המתקפה גיליתי בעקבות שיחה עם חבר שאמר לי שקיימת לצוות שלו בעיה בעבודה עם 

ומשום מה הקונטיינר שלהם קורס  Javaאפליקציה מבוססת  עבור הרצה של Dockerהם מנסים לעבוד עם 

 כל הזמן.

פנוי יש  RAMכאשר קונטיינר בודק כמה  שזה כנראה קשור לעובדה המעניינת:הוא אמר לי שהם בדקו ו

שעליו  Host-פנוי יש ל RAMשלו אלא כמה  instance-פנוי יש ל RAMלו, הוא לא מקבל תשובה לגבי כמה 

 הוא יושב.

העניין היה נשמע לי ממש מוזר, ואמרתי לו שאני אחקור על הנושא. חקרתי ומסתבר שהוא צדק בהתחלה 

 Host-של ה proc/meminfo/ לקובץ mountמבצע  Docker Engineובאמת כאשר קונטיינר עולה אז 

 בלינוקס.

פעלה / הינה "פסודו" מערכת קבצים )היא לא באמת קיימת על הדיסק עצמו(, והמערכת הprocהתיקיה 

 processesדואגת לייצר אותה ולשמור אותה בזיכרון. היא נועדה לספק מידע על המערכת )בדגש על 

שמטרתו להציג סטטיסטיקה הוא "קובץ מיוחד"  proc/meminfo/במערכת ומכאן נובע השם שלה(. הקובץ 

 .על הזיכרון של המערכת

 :man pageזאת ההגדרה שלו לפי  

This file reports statistics about memory usage on the system. 

It is used by free(1) to report the amount of free and used 

memory (both physical and swap) on the system as well as the 

shared memory and buffers used by the kernel. 

 .כאן בהרחבה עליו לקרוא ניתןלמתעניינים: 

לא היה  JVM-ה בצוות של חבר שלי היו מרימים קונטיינרים עם הגבלת זיכרון כלשהי. נחזור לסיפור שלנו:

הבעיה הייתה . garbage collector-ן הוא לא היה קורא לולכ מודע להגבלה שביצעו על הקונטיינר

 הוא כן היה מוגבל בכמות הזיכרון ולכן הוא היה מקריס אותו! Docker engineשמבחינת 

 לקרוא כאן:לקריאה מורחבת על הנושא כולל פתרון של הבעיה מוזמנים 

https://developers.redhat.com/blog/2017/03/14/java-inside-docker/ 

 Hostהנקודה החשובה ביותר שעלתה לי ברגע שהבנתי את הסיפור היא שבעצם קונטיינר שרץ על 

-מידע שלכאורה לא הייתי רוצה שהוא ידע, כלומר כל המידע לגבי מצב הזיכרון של ה כלשהו יכול לדעת

Host. 

ויותר חמור מזה הוא גם יכול להשפיע על המידע הזה בצורה מאוד קלה על ידי הקצאה פשוטה של זכרון. 

 .גם יכולים לראות את המידע שהוא ישנה שם Hostובמקביל קונטיינרים אחרים שגם רצים על אותו 

http://man7.org/linux/man-pages/man5/proc.5.html
http://man7.org/linux/man-pages/man1/free.1.html
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://www.thegeekdiary.com/understanding-proc-meminfo-file-analyzing-memory-utilization-in-linux/
https://en.wikipedia.org/wiki/Java_virtual_machine
https://www.journaldev.com/16659/garbage-collection-in-java
https://developers.redhat.com/blog/2017/03/14/java-inside-docker/
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שתאפשר לנו  Covert Channel attackואז נפל לי בעצם האסימון שקיים פה פוטנציאל להתקפה מסוג 

 ליצור ערוץ תקשורת סמוי בין שני קונטיינרים.

הוא יכול פשוט להפוך את המידע לצורה  Bירצה להעביר מידע כלשהו לקונטיינר  Aהרי אם קונטיינר 

-" ו0אה של כמות קבועה מראש של זיכרון הוא יוכל להעביר "בינארית, ואז באמצעות הקצאה או אי הקצ

 .B-" שמייצגים את הבינארי ל1"

 meminfoהסיפור לא נגמר כאן! תוך כדי מחקר על הבעייתיות בשיתוף המידע הקיים באמצעות הקובץ 

שמזכיר את הנקודה החשובה שקיים עוד מקום שבו קונטיינר יכול לראות  הזה המעולה מאמרנתקלתי ב

זה בעצם קריאה למערכת הפעלה ובקשה  Syscall sysinfo-, המקום הזה הוא הHost-מידע הניתן לשינוי ב

 לגבי משאבי המערכת. לקבל ממנה מידע 

 :הקטע המעניין במאמר

 

 :Syscall sysinfo-מה שבעצם אומר שקיים עוד מרחב שבו אפשר להעביר מידע, הסתכלתי קצת על ה

 

https://fabiokung.com/2014/03/13/memory-inside-linux-containers/
https://fabiokung.com/2014/03/13/memory-inside-linux-containers/
https://fabiokung.com/2014/03/13/memory-inside-linux-containers/
https://fabiokung.com/2014/03/13/memory-inside-linux-containers/
https://fabiokung.com/2014/03/13/memory-inside-linux-containers/
https://fabiokung.com/2014/03/13/memory-inside-linux-containers/
https://fabiokung.com/2014/03/13/memory-inside-linux-containers/
https://fabiokung.com/2014/03/13/memory-inside-linux-containers/
https://fabiokung.com/2014/03/13/memory-inside-linux-containers/


 
 

 קונטיינרים שני בין חשאי תקשורת ערוץ יצירת
www.DigitalWhisper.co.il 

 42  2019 אפריל, 105גליון 
 

. מיהרתי לבדוק מידע על כמות התהליכים שרצים כרגע במחשבוראיתי שאחד השדות שהוא מחזיר זה 

נטיינר אחד יכול לדעת מה סך כל התהליכים הרצים באמת קואת הנושא על שני קונטיינרים ומסתבר ש

! ולכן אפשר להכין גם עוד ערוץ תקשורת כולל אלו הרצים בתוך קונטיינרים אחרים Host-כרגע על ה

כמו הדוגמא המצורפת של שיהיה מבוסס על שינויים בכמות התהליכים הרצים בכל רגע נתון, בדיוק 

 מות הזיכרון שבשימוש.כשינויים ב

וכן  Sysinfoריך שאם נשקיע עוד כמה שעות מחקר בשימושים הנוספים האפשריים בכל השדות של אני מע

נוכל למצוא בוודאי עוד דרכים להעביר מידע אך הדוגמאות פה מספיקות  Meminfo-בכל השדות שב

)כמובן שאתם  בין קונטיינרים Covert channelלהעברת הרעיון שקיימים דרכים להעביר מידע בצורת 

 .וזמנים לספר לי על רעיונות נוספים(מ
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   מימוש

“Talk is cheap. Show me the code.” - Linus Torvalds 

הכנתי הדגמה יחסית פשוטה שמראה את הרעיון המתואר בפרק השני, בהדגמה ההנחה היא שקיימת 

זה היכולת  והדבר היחיד שחסר לתוקף Hostכבר אחיזה של התוקף בשני קונטיינרים שרצים על אותו 

 שאין ביניהם תקשורת.להעביר ביניהם מידע מכיוון שהם מקונפגים בצורה כזאת 

ההדגמה מנסה להמחיש את היכולת של קונטיינר אחד לשלוח פקודה לקונטיינר השני על מנת שהוא יבצע 

 .(C&C)אותה 

 :גמה מכילה שני קבציםההד

  קובץ אחד נקראsender.py .זה הקובץ שהקונטיינר שרוצה לשלוח מידע כלשהו מריץ 

  וקובץ נוסף שנקראreceiver.py .שזה הקובץ שהקונטיינר שרוצה לקבל את המידע מריץ 

חשוב לי לציין: ההדגמה לא מתייחסת בצורה רצינית לעובדה שייתכן ויש עוד הרבה דברים שרצים 

, כלי תקיפה אמיתי אשר ירצה להשתמש בשיטת RAM-מקביל אשר משפיעים גם על מצב השימוש בב

, מנגנוני תזמון, סנכרון שגיאות תיקון יכולתתקשורת זו יאלץ להרכיב על גביה פרוטוקול שיחה שלם, ובו 

 יחסית יציב וכו'. Host-ים להקצאה, זמנים בהם ה-Bufferגודל של 

 .כאןאת הקוד המלא אפשר למצוא 

 

 :הוא sender.pyהחלק המרכזי ביותר של 

string_to_send = raw_input("Enter your command:\n") 

 

# Append the first zero since we're sending ascii values 

bin_to_send = "0" + bin(int(binascii.hexlify(string_to_send), 16))[2:] 

 

raw_input("Press Enter to start sending...\n") 

 

logger.info("Synchronize bit window time") 

while datetime.datetime.now().second % 20 != 0: 

    time.sleep(0.1) 

 

for curr_binary in bin_to_send: 

    if curr_binary == "1": 

        # save in memory 

        temp = "a" * BYTES_IN_RAM_TO_USE 

        time.sleep(time_between_send_one) 

        del temp 

        logger.info("{} : Send : 1".format(datetime.datetime.now())) 

    else: 

        time.sleep(TIME_BETWEEN_SEND_ZERO) 

  

https://en.wikipedia.org/wiki/Botnet#Organization
https://he.wikipedia.org/wiki/%D7%A7%D7%95%D7%93_%D7%AA%D7%99%D7%A7%D7%95%D7%9F_%D7%A9%D7%92%D7%99%D7%90%D7%95%D7%AA
https://he.wikipedia.org/wiki/%D7%A7%D7%95%D7%93_%D7%AA%D7%99%D7%A7%D7%95%D7%9F_%D7%A9%D7%92%D7%99%D7%90%D7%95%D7%AA
https://he.wikipedia.org/wiki/%D7%A7%D7%95%D7%93_%D7%AA%D7%99%D7%A7%D7%95%D7%9F_%D7%A9%D7%92%D7%99%D7%90%D7%95%D7%AA
https://he.wikipedia.org/wiki/%D7%A7%D7%95%D7%93_%D7%AA%D7%99%D7%A7%D7%95%D7%9F_%D7%A9%D7%92%D7%99%D7%90%D7%95%D7%AA
https://he.wikipedia.org/wiki/%D7%A7%D7%95%D7%93_%D7%AA%D7%99%D7%A7%D7%95%D7%9F_%D7%A9%D7%92%D7%99%D7%90%D7%95%D7%AA
https://he.wikipedia.org/wiki/%D7%A7%D7%95%D7%93_%D7%AA%D7%99%D7%A7%D7%95%D7%9F_%D7%A9%D7%92%D7%99%D7%90%D7%95%D7%AA
https://he.wikipedia.org/wiki/%D7%A7%D7%95%D7%93_%D7%AA%D7%99%D7%A7%D7%95%D7%9F_%D7%A9%D7%92%D7%99%D7%90%D7%95%D7%AA
https://he.wikipedia.org/wiki/%D7%A7%D7%95%D7%93_%D7%AA%D7%99%D7%A7%D7%95%D7%9F_%D7%A9%D7%92%D7%99%D7%90%D7%95%D7%AA
https://he.wikipedia.org/wiki/%D7%A7%D7%95%D7%93_%D7%AA%D7%99%D7%A7%D7%95%D7%9F_%D7%A9%D7%92%D7%99%D7%90%D7%95%D7%AA
https://github.com/YehudaCorsia/Docker-Covert-channel
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 הסבר:

 מקבלים מהמשתמש פקודה שאותה נרצה לבקש מהקונטיינר השני לבצע. .1

 אנחנו מעבירים אותה לפורמט בינארי. .2

אנחנו מחכים עד לזמן שהגדרנו מראש בשני הצדדים, כרגע זה סתם המתנה של עד הרגע שבו  .3

רים בלי שארית. הסיבה להמתנה היא שאנו רוצים לוודא ששני הקונטיינ 20-השניות מתחלקות ב

 מסונכרנים בדיוק על השנייה שבה הם מתחילים להעביר ביניהם את המידע.

' 1אנחנו עוברים על הערך הבינארי שאנחנו רוצים להעביר, לדוגמה אנחנו רוצים להעביר את הערך ' .4

 אז נקצה בזיכרון משתנה בגודל קבוע מראש, נחכה גם כן זמן שקבוע מראש עם הקונטיינר הנוסף.

 ' אז נחכה רק את הזמן אשר קבוע בין שני הקונטיינרים.0ר את הבינארי 'ואם נרצה להעבי

 הינו: receiver.py-במקביל, הקטע קוד המרכזי ב

raw_input("Press Enter to start receiving...\n") 

logger.info("Synchronize bit window time") 

while datetime.datetime.now().second % 20 != 0: 

    time.sleep(0.1) 

 

need_get_more_binary = True 

while need_get_more_binary: 

    curr_binary_string = "" 

    for i in range(SIZE_BYTE_IN_BINARY): 

        curr_binary_string += check_if_transform_data() 

 

    if curr_binary_string == NULL_ASCII_BIN_STR: 

        logger.info("get null, so finish transfer.") 

        need_get_more_binary = False 

    else: 

        n = int(curr_binary_string, 2) 

        full_receive_string += binascii.unhexlify('%x' % n) 

 

logger.info("Receiving : {}\n".format(full_receive_string)) 

logger.info("Running it as a command...") 

os.system(full_receive_string) 

 sender-מסנכרנים את השעה בדיוק כמו ב .1

 )שמונה אפסים( שמסמן עצירה. nullנקבל עוד ועוד ערכים בינארים עד שנקבל  .2

 שנוצר. string-כל פעם משרשרים ל .3

 בסוף מריצים את זה בתור פקודה. .4

ומי שרוצה מוזמן גם להרחיב אותו או לכתוב שם המלצות  Github-המלא ב אני ממליץ לעבור על הקוד

-לבדוק את זה אצלו מוזמן להשתמש ב שמעונייןמי . לא יזיק  Star-לשיפור )יש המון( וגם לפרגן ב

Images  את הפקודות הבאות בשני המוכנים כלומר פשוט להריץterminals שונים: 

docker run --network=none -it yehudacorsia/docker-covert-channel-sender 

 
docker run --network=none -it yehudacorsia/docker-covert-channel-receiver 

 ולראות את הקסם קורה.

 .Github-ב המופיעים Dockerfiles-בעצמו מה Images-מי שרוצה מוזמן לבנות את הבנוסף, 

https://github.com/YehudaCorsia/Docker-Covert-channel
https://github.com/YehudaCorsia/Docker-Covert-channel/tree/master/src/Dockerfiles
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https://github.com/YehudaCorsia/Docker-Covert-channel/tree/master/src/Dockerfiles
https://github.com/YehudaCorsia/Docker-Covert-channel/tree/master/src/Dockerfiles
https://github.com/YehudaCorsia/Docker-Covert-channel/tree/master/src/Dockerfiles
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 Senderמצד ימין רואים את  ריצה של שני הקונטיינרים במקביל.הדגמה של הבתמונה הבאה ניתן לראות 

התמונה התחלת השליחה של המידע,  ניתן לראות אתתמונה הראשונה ב .receiverאת ומצד שמאל 

 :receiver-השליחה וביצוע הפקודה על ידי ה מראה את המצב בגמרהשנייה 

 

 

 .כאןהכנתי גם סרטון שמראה את ההדגמה ואפשר לראות אותו 

https://youtu.be/Zh4gNfVhnl8
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 Dockerתגובת 

-בצירוף הקוד, וכל השיחה איתם מופיעה ב Dockerי כמובן את המידע לגבי החולשה לחברת שלחת

Github :של הפרויקט, זה חלק מהתגובה שלהם 

Thanks for this report (and neat PoC), unfortunately we don't agree that 

this is a vulnerability -- for a few reasons. 

 

1. In order to exploit this you already have two containers that you 

   wish to communicate on a target system -- which means that you 

   already have code-execution within containers on the system and they 

   are mutually co-operative. In other words, there is no "victim" 

   process. I'm sure this would be a neat trick if you manage to get 

   "blind container execution" to exfiltrate information between 

   containers, but given that all the processes are co-operative I don't 

   see this as an issue. 

 

2. This issue is actually a kernel issue (/proc/meminfo and the other 

   memory-info APIs aren't cgroup-aware, leading to information about 

   global system resources being scoped inside the container). As you 

   said, this issue has been known about for a really long time -- but 

   kernel developers have categorically stated they aren't interested in 

   /proc/meminfo becoming cgroup-aware because of how complicated the 

   infrastructure would be to make it work. So, we don't really have the 

   ability to fix the fundamental issue. 

 

   There is a project called LXCFS which allows you to mask 

   /proc/meminfo in containers, and you could use this to prevent some 

   of the problem -- but there are other memory-info APIs that can't be 

   fixed so easily. You could trick them with the new seccomp 

   RET_USER_NOTIF API, but that would not help older kernels and so on 

   (and ptrace would kill performance in containers by a fair amount, 

   and break gdb). 

 

3. Isolating machines to avoid side-channels like this is almost an 

   intractable problem -- because at the end of the day you are running 

   on the same hardware and there will always be hardware tells (latency 

   in HDD access or even CPU load -- both can be limited with cgroups 

   but you'd likely be able to tell). Even VMs are vulnerable to 

   side-channels like this, because shared-tenant systems fundamentally 

   have to share resources that aren't designed to be side-channel 

   resistant. 

אעיר ואומר שבנוגע לנקודה הראשונה שלהם אני מסכים עם הנקודה שזה דורש משהו לא טריוויאלי 

כלומר זה דורש באמת הרצת קוד על שני קונטיינרים אבל זה עדיין לא סותר את העובדה שזה כן מאפשר 

ולהעביר מידע בין שני תהליכים שצריכים לנו יכולת שמעניינת תוקפים והיא היכולת לעבור בין רשתות 

 להיות נפרדים וכולי.

סקופ הבעיה כאן הוא הרבה שבנוגע לנקודה השנייה שלהם, היא כמובן נכונה והיא בעיקר מביאה לנקודה 

בנוגע לנקודה השלישית, אמנם זה נכון . היא רק היבט אחד שלה Docker-יותר גדול וההשפעה שציינתי ב

, אך הם יהיו הרבה יותר מסובכים עד כדי לא אפשריים לעומת VMמות גם על שייתכנו מתקפות דו

 .) hereside channel attack in VM's(החולשות המתוארות פה 

https://github.com/YehudaCorsia/Docker-Covert-channel/blob/master/docs/Conversation%20with%20Docker.md
https://github.com/YehudaCorsia/Docker-Covert-channel/blob/master/docs/Conversation%20with%20Docker.md
https://arxiv.org/abs/1606.01356
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 מה עוד?

ים, ניתן לעשות לבין כלל הקונטיינר Host-כמו שאתם יכולים להבין, בהינתן ממשק משותף וחשאי בין ה

עוד מספר רב של דברים, ויצירת ערוץ דלף הוא רק יישום אפשרי אחד. להלן מספר דוגמאות נוספות 

 שניתן לממש:

 Side channel attack - :ניתן לחלק את סוגי המתקפות בעולם המחשבים  ואסביר קצת על הנושא

 לשני סוגי מתקפות עיקריות:

o  הסטנדרטיות שאנו מכירים. בהן  , אלו הן ההתקפותהתקפה ישירהסוג המתקפה הראשון הוא

התוקף מבצע מתקפה ישירה על המטרה. ולאחר מכן מצליח להשיג הרשאות אשר לא ניתנו לו 

  מראש.

o  או באנגלית התקפה עקיפהסוג המתקפה השני, והמעט פחות מוכר, הינו( Side channel attack .)

התקפות מסוג  של המגזין: 79-ופורסם בגיליון ה סיני יובל מאת מאמרעל הנושא נכתב בהרחבה 

Side channel attack  יהיו התקפות עקיפות על מטרתו של התוקף. בהן במקום לבחון את המידע

נחפש נגזרות שלו באופן עקיף ואותן ננסה לנתח. הדוגמאות  -פן ישיר שאותו נרצה לתקוף באו

המוכרות הן בדיקת הזמן שלוקח לפעולת חישוב להתבצע, צריכת חשמל, רעש או טמפרטורה 

שמעגל מסויים צורך או מפיק, ועל פי הנתונים הללו להסיק מסקנות על התהליך ובכך לחשוף 

 נתונים על המטרה שלנו באופן עקיף.
 

עוד שהמטרה של סוג המתקפה הראשון יהיה להשיג יכולות כגון הרצת קוד על המטרה, שינוי ב

הרשאות או עריכה של מידע, המטרה של המתקפה השניה תהיה הרבה פחות מוגדרת ושלמה 

מקרים תהיה רק חלק משרשרת חולשות שישרתו בסופו של דבר מטרה גדולה יותר. ובהרבה 

דוגמאות לתוצאות של מתקפות צדדיות יכולות להיות: הבנה האם תהליך פענוח הצליח )ללא ידיעת 

התוכן שפוענח(, הבנה האם נעשה שימוש באלגוריתם דחיסה ספציפי וכדומה. הרעיון הוא שברוב 

התוצאה הישירה שנרצה לקבל, אלא איזשהו נתון עקיף שבעזרתו נוכל להסיק המקרים, לא נקבל את 

 מסקנות על מטרת התקיפה שלנו.
 

למרות שעל פי שתי הפסקאות האחרונות ניתן לחשוב בטעות כי סוג המתקפות השני הוא סוג 

בעזרת סוג מתקפות זה הצליחו בלא מעט פעמים לרסק  -מתקפות "חלש" יותר, אין לזלזל בו 

אשר מתבססות על קונספטים  -מהמפורסמות ביותר  -גוריתמי הצפנה כבדים מאוד, וחולשות אל

 .)TLS על CRIME-ו BREACHלדוגמא, או  Spectre-ו Meltdownמסוג זה )
 

בשימוש וכן מה הם מספר התהליכים  RAM-ובמקרה שלנו, כאשר אנו יכולים לדעת מה כמות ה

 Side channelר מספיק מקיף נוכל להצליח לבצע המון מתקפות מסוג ועם מחק Host-הרצים כרגע ב

attack  לדוגמא להצליח לשבור הצפנה של קונטיינר שמצפין מידע ונמצא גם על אותוHost זיהוי של ,

סוג השרת הנמצא בקונטיינר לידינו גם אם הוא מנסה לבלבל אותנו ומסתיר את סוג השרת )מוזמנים 

של אפיק קסטיאל, בכללי לא ארחיב כעת רק אומר שהתחלנו  המצוין מאמרבלקרוא עוד על הרעיון 
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מחקר בנושא ויש לבינתיים תוצאות מאוד מעניינות ואולי בקרוב יתפרסם מאמר המשך עם מימוש 

 ( ועוד אינספור דברים שכבר בוצעו בעבר בנושא ודברים נוספים בסגנון שלהם.העניין של 

 

 כרגע ההדגמה היא יחסית מאוד פשוטה אך ניתן לשפר אותה באמצעות  - יפור רוחב הערוץש

 וכדומה meminfo-ואף באמצעות שימוש בתאים נוספים שניתן לשלוט עליהם ב דחיסה אלגוריתמי

 

 Hide and Seek with AVs - ערוץ שאינו מפוקח ע"י תוכנת ה-Antivirusע"י הרצת ה :-sender.py וה-

receiver.py נים על אותו תהליכים שוערוץ תקשורת חשאי בין שני  על אותה המכונה, ניתן ליצור

יצירת קובץ, כגון ישירים אשר מחפשות קישורים  Antivirusובכך להתחמק מתוכנות כגון  הקונטיינר

ובדיקה איזה תהליכים אחרים ניגשים אליו, או כתיבה ישירה לזיכרון של תהליך אחר. באמצעות 

תהליכים באופן  יצירת פרוטוקול תקשורת המתבסס על הקצאת ושחרור זיכרון ניתן להעביר מידע בין

 .עקיף

 

  בחרתי להראות את הדוגמא ספציפית עלDocker  אבל כמו שכבר צוין היקף הבעיה הוא הרבה יותר

גדול, ואפשר באמצעות החולשה הזאת להצליח להעביר מידע בין שני תהליכים גם על רכיב המריץ 

Linux  .בצורה רגילה ולהרוויח את היתרונות המוזכרים לעיל 

  

https://en.wikipedia.org/wiki/Data_compression
https://en.wikipedia.org/wiki/Data_compression
https://en.wikipedia.org/wiki/Data_compression
https://en.wikipedia.org/wiki/Data_compression


 
 

 קונטיינרים שני בין חשאי תקשורת ערוץ יצירת
www.DigitalWhisper.co.il 

 49  2019 אפריל, 105גליון 
 

 סיכום

ודה המרכזית שרציתי להראות במאמר זה שכאשר חושבים על כל הנושא של הפרדה רשתית חשוב הנק

לשים לב שאם ההפרדה באמת חשובה לנו גם מבחינה אבטחתית, אנו צריכים תמיד לשקול את 

האפשרות להשתמש בהפרדה חזקה יותר מאשר ההפרדה הפשוטה שמקבלים באמצעות קונטיינרים, 

 Dockerים שהיא כידוע הרבה יותר חזקה, אך כמו שגם -vmש בהפרדה של בדרך כלל נרצה להשתמ

 covert או side channel attackים ייתכנו מתקפות מסוג -vmבעצמם ציינו גם בהפרדה באמצעות 

channel  מ בריחהוכן ייתכנו התקפות של-VM  אשר ראוי לקחת בחשבון ולכן לפעמים נרצה ממש הפרדת

Air gap חשוב שוב לציין שאמנם ההתקפות מהסוג הנ"ל ייתכנו גם ב-VM  אבל הם יהיו משמעותית הרבה

 יותר קשות עד בלתי אפשריות.

איננה מתייחסת לעניין זה כאל נושא שצריך לתקן אותו, ולכן הדרך הטובה  Dockerכמו שראיתם, חברת 

פשוט להכיר אותו, לדעת שהוא שם ולהתייחס אליו כאשר מאפיינים את  -ביותר להתגונן מפניו הוא 

 אבטחת המערכת עוד בשלב התכנון שלה.

אינו מתיימר להיות פתרון  Docker-להבין ש כאשר מדברים על התגוננות מפני מתקפות אלו, חשוב

אבטחתי. ולכן אין להסתמך עליו כאל פתרון זה. במידה ונרצה לספק הפרדה אמיתית בין רשתות / 

לבצע הפרדה פיזית בין , NERCמערכות עלינו לבצע זאת באופן פיזי. ניתן לקרוא וליישם את ההמלצות של 

 הרשתות הארגוניות לבין הרשתות המבצעיות.

 תוך כדי כתיבת המאמר, אפיק קסטיאל הפנה את תשומת ליבי למחקר מרתק שנעשה בתחום.

באנדרואיד  Side channel attackמדובר על קבוצת חוקרים שיצרו כלי אוטומטי לזיהוי חולשות מסוג 

 .שלהם המחקר/ ממליץ בחום רב לקרוא את proc-פגיעויות הקשורות בהמבוססות על 

 

 על המחבר

 יהודה כורסיה הוא חוקר ומפתח יכולות הגנה בדגש על טכנולוגיות ענן.

  :אימיילyehudacorsia@gmail.com 

  :גיטהאבhttps://github.com/YehudaCorsia 

 :טוויטר https://twitter.com/YehudaCorsia  
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 מדריך לחוקר המתחיל -ים -CVEרישום 

 אייל איטקיןמאת 

 

 הקדמה

ח ואפילו הצלחת להרים אז התחלת מחקר, מצאת חולשה מגניבה במוצר מסחרי / ספריית קוד פתו

 responsible"אבל זה לא הסוף, עכשיו צריך להתחיל בתהליך הבירוקרטי של  הדגמה מגניבה, סחתיין 

disclosure"  והוצאתCVE .רשמי לחולשה שמצאת 

ילך לכם בצורה החלקה ביותר, מקווה שתמצאו אותו  CVE-מדריך זה נכתב על מנת שתהליך רישום ה

 מועיל.

 :שוליים הערת

 מדריך זה )כמעט( ולא יעסוק בתהליך ה-"responsible disclosure" עם זאת, המדריך יכלול המלצות בנוגע לסנכרון הזמנים .

 בין שני התהליכים הנ"ל.

  מדריך זה נכתב מנסיוני האישי כחוקר עצמאי וכחוקר כיום בחברתCheck Point עם זאת, המדריך נכתב מנקודת מבטי .

 זמתי האישית, ללא קשר למעסיק שלי.האישית כחוקר, וביו

ים, המדריך נכון למועד כתיבתו וכולי תקווה -CVE-למרות שמדי פעם ישנם שינויים בבירוקרטיית רישום ה

 שיהיה מועיל ככל הניתן גם בעתיד.

 מבוא

 קצת מונחים

 לפני שנתחיל, בואו נסביר את המונחים השונים:

 CVE - Common Vulnerability and Exposureערכי( לחולשה-חד-: מזהה ייחודי )חד 

 CNA - CVE Numbering Authorityגוף או חברה אשר מורשה להנפיק מזהי חולשות : 

 CWE - Common Weakness Enumerationערכי לסוג טכני של חולשה-חד-: מזהה חד 

 MITRE (הגוף הראשי האחראי על רישום לינק :)והפצת מזהי החולשות 

 NVD - National Vulnerability Database (מאגר פומבי נוח של מזהי החולשות שהתפרסמו לינק :)

 ת ארה"ב.ללאורך ההיסטוריה. המאגר מנוהל ומתוחזק על ידי ממש

 . כלומר, בדוגמה זו:CVE-2016-1234עד לשנים האחרונות, מזהה החולשה היה מהצורה הבאה: 

  במידה והתיקון מתעכב, החולשה לפעמים תתפרסם בשנה העוקבת  - 2016בשנת  נרשמההחולשה

 למשל(. על כן החלק הראשון במזהה מציין מתי החולשה התחילה את תהליך הרישום. 2017)

 1234 - ערכי )חח"ע( של החולשה בשנה בה היא נרשמה.-חד-מזהה חד 

https://cve.mitre.org/
https://nvd.nist.gov/
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 ים?-CVEלמה קיימים 

ים כדי לנופף בכמה חולשות הם מצאו, לא זו המטרה המקורית -CVE-בעוד שחוקרים רבים משתמשים ב

 לשמה הוחלט לתת מזהים לחולשות. מזהה חולשה תוכנן כך שיהיה חח"ע, בכדי לעמוד במספר יעדים:

בתהליך תיאום וסינכרון בין צוות המחקר ובין הגוף או הגופים הפגיעים לאותה החולשה, ונמצאים  .1

 :התיקון שלה

a.  0160-2014דוגמא טובה לכך היא-CVE ( הידוע גם בכינויheartbleed) 

b.  במקרה הזה מספר רב של גופים נדרשו לתקן את אותה החולשה שנבעה מספריית קוד פתוח

 מאוד פופולארית, ששולבה במספר רב של מוצרים ושרתים

c. תן לחולשה רק לאחר הפרסום שלה כאמצעי מיתוג שנוי במחלוקת )פרקטיקה השם עצמו ני

 שנהוגה גם כיום, אם כי בעצימות נמוכה יותר(

 :עדכון הציבור בנוגע לתיקון חולשה .2

a. בעולם תקין( מזהה החולשה יופיע ב(-Git Commit )שמתקן את החולשה )קוד פתוח 

b. בעולם תקין( מזהה החולשה יופיע ב(-Release Notes של הגרסה המתוקנת של המוצר 

 במקרה הפחות טוב, עדכון פומבי של הציבור בנוגע לחולשה שטרם תוקנה: .3

a. ( עבור חולשות שנמצאו כשהן מנוצלות בפומבי“in the wild”ללא דיווח של חוקר ליצרן ) 

b. במקרים בהם המוצר לא תוקן בחלון הזמנים שהחוקר הגדיר, או שהיצרן בחר שלא לתקן 

 הוא השם המדעי של החולשה, והוא תוכנן כך שיהיה ייחודי וברור.  CVEאו בקיצור, 

 מאחורי הקלעים

 4בשנים האחרונות דווחה כמות גבוהה יחסית של חולשות, ובכל שנה מחדש נגמר מאגר המזהים בני 

הספרות של אותה השנה... כדי להתמודד עם הבעיה הוחלט להאריך את מזהי החולשות, ולכן כיום חלק 

מתאר חולשה שדווחה בסוף שנת  CVE-2018-20174ספרות ויותר. לדוגמא: המזהה  5הים כוללים מהמז

 .4ספרות במקום  5ולכן קיבלה מזהה של  2018

 מכיוון והמזהים מחולקים לשנים, מאחורי הקלעים מתבצע תהליך הרישום הבא:

ולשות, כדי שיוכלו בלוקים של מזהי ח MITRE-ים השונים יבקשו מ-CNA-בתחילת השנה )לרוב( ה .1

 להשתמש בהם במהלך השנה

 בלוק נוסף של מזהים לאותה השנה MITRE-יכול לבקש מ CNAבמידה ובלוק המזהים נגמר,  .2

3. MITRE  גם היא מתפקדת בתורCNAולכן היא שומרת לעצמה בלוק מכובד של מזהי חולשות , 

ים עם מזהים גדולים יותר פשוט תקצה בלוקים חדש MITREבמידת הצורך, עם כל הבלוקים "נגמרו",  .4

 ספרות בשנה מסויימת( 4-)ולכן אפשר להגיע גם למזהים של יותר מ

תקצה  MITREמזהים.  100בלוק של  MITRE-ביקשה מ Googleחברת  2019לדוגמא, נגיד שבתחילת שנת 

-CVEועד  CVE-2019-2200לה בלוק של מזהים והיא תקבל לאחריותה את כל המזהים בתחום. למשל: 

יראה כי כל אחד מהמזהים בתחום הוא  MITRE. מרגע שההקצאה התבצעה, האתר של 2019-2300

http://heartbleed.com/
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לא נמצא אזכור לאף אחד מהמזהים הנ"ל, בגלל שהם  NVD(. לעומת זאת, באתר של reserved"שמור" )

 עדיין לא הוקצו רשמית לחולשות ספציפיות.

חולשות שדווחו באותה השנה.  10,000ספרות לא יעיד על כך שהיו  5קיומו של מזהה בעל  שימו לב:

בסיכוי סביר להרבה מהחברות יש בלוקים של מזהים לא מנוצלים, משום שהקצאה בבלוקים היא מטבעה 

 לא יעילה.

 

 ולמה זה חשוב? CNAאז מי בכלל 

המתאים ביותר, זה  CNA-כשבאים לדווח לחברה / פרויקט קוד פתוח על חולשה, נרצה לפנות ל

שניתן לה. לשם כך חשוב להבין מי  CVE-את החולשה שמצאנו ולהקצות עבורנו את ה שבאחריותו לרשום

 השונים: CNA-הם ה

ים שישמש אותן כדי -CVEויקבלו בלוק של  CNA-( ישמשו בד"כ כAdobeחברות מסחריות )כדוגמאת  .1

 לרשום את החולשות שנמצאו במוצרים של החברה

 (Google)כדוגמאת משולב  CNA-חברות פיתוח ומחקר ישמשו בד"כ כ .2

a. רישום של חולשות במוצרי החברה 

b.  רישום של חולשות שנמצאו על ידי חוקרי החברה, במקרים בהם לא נמצא גוף מתאים יותר בכדי

 לרשום את החולשה בעצמו

 למשל( Linuxפרויקטי גוף פתוח גדולים מספיק )קהילת מפתחי הקרנל של  .3

4. MITRE )ג'וקר( 

a. במידת הצורך אפשר לפנות ל-MITRE  ישירות להנפקתCVE )יפורט בהרחבה בהמשך( 

 Distributed Weakness Filing Project (DWF) -כל השאר  .5

a. לשות בפרויקטי קוד פתוח קטנים, ושנמצאו על לכאן ידווחו כל החולשות שאין למי לדווח, לרוב חו

 CNAידי חוקרים עצמאיים / חוקרים מחברות שאינן 

b. הוספת ה-CNA הזה היא שינוי של השנים האחרונות, שנועד להפחית עומס מ-MITRE 

 .MITREלאתר של  לינק הבאאפשר למצוא ב CNA-את הרשימה המלאה של כל גופי ה

 MITRE-פנייה ישירה ל

)בתפריט יש לבחור  לינק - CVEיש טופס נוח למילוי כל הפרטים הנדרשים לרישום  MITREבאתר של 

יהם, אבל (. ישנם מספר מקרי קצה בהם נרשה לעצמנו לפנות ישירות אל”Request a CVE ID“באופציה 

 איטי מדי. DWFהעיקרי שבהם הוא שאתם מוגבלים בזמן והתהליך דרך 

אני נוהג לכתוב בהערות למה פניתי ישירות אליהם, ועד עכשיו התהליך היה  MITRE-בכל פנייה ישירה ל

 חלק.

https://docs.google.com/forms/d/e/1FAIpQLSddsMgF0JuiMlcURdmVuIdGtEgDNKXhjNy6ZoRwGrSb6Ty60g/viewform
https://cve.mitre.org/cve/request_id.html
https://cveform.mitre.org/
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 CVEהנפקת 

 אני צריך לעשות משהו בעצמי?

ים, לרוב -CVE-ל בעצמו את הקצאת הפעמים רבות, החולשה מדווחת לחברה / פרויקט קוד פתוח שמנה

 . דוגמאות:CNAמכיוון שהגוף האחראי על המוצר הינו 

שיוקצה ישירות על ידי המפתחים של  CVEשמתוייגים כאבטחתיים, יקבלו  PHPבאגים בקוד של  .1

PHP זמן טוב בד"כ גם להגיש את מה שמצאתם ל(-bug bounty שלהם ב-hackerOne.) 

או רוב החברות הגדולות יטופלו על ידי החברה  Google ,Microsoftבאגים בקוד של מוצרי  .2

 שהוקצה לה CVE-עצמה, והיא תעדכן אתכם מה ה

 , יש לכך גם מספר חסרונות:CVE-בעוד שבמקרים אלו נחסך מכם הצורך לרשום בעצמכם את ה

שיועילו ועלול להכיל טעויות או שבקושי יכלול פרטים טכניים  CNA-תיאור החולשה יכתב על ידי ה .1

 " וזהו(Yשעלולה לגרום  Xלחוקרים אחרים )"נמצאה חולשה במודול 

, ובמקרה שהוא היצרן הוא מטבעו ינסה להפחית CNA-חומרת החולשה תדורג על ידי ה .2

 מחשיבות הנזק שנמצא במוצר שהוא פיתח

 או בקיצור, מי שכותב את הפרטים שולט בהיסטוריה.

ים ואחרי שאישרו את נכונות החולשה )ולא ישר במייל הראשון במהלך תהליך דיווח החולשה למפתח טיפ:

. זאת כדי להבין האם אתם CVE-שנשלח(, רצוי לשאול אותם אם אפשר "לסייע להם" בתהליך הקצאת ה

 צריכים לעשות זאת, או שהם יקחו את האחריות לכך.

 CVEצתם עדיין לא מעט פרויקטי קוד פתוח יגידו לכם כחלק מתהליך התיקון שאם לא הק מלכוד:

לחולשה, אז הם יעדיפו שכבר לא יוקצה לה מזהה כלל. במקרה כזה תרצו להחליט האם להנפיק בעצמכם 

 מזהה בכל זאת או לוותר על זה. את ההחלטה רצוי לעשות כתלות בחומרת החולשה שמצאתם.

 מתאים, מה עכשיו? CNAוגם מצאתי  CVEבאחריותי להנפיק 

 שים:חלק זה יתפצל בין שני תרחי

 כנראה שזה התרחיש הנפוץ - CNA-חוקר עצמאי שאינו חלק מ .1

 CNAחוקר שעובד בחברה שהיא  .2

 אני חוקר עצמאי

 :CNAדרכים נפוצות לפנות אל  3יש 

 שעות )די מהיר( 24-48מענה ראשוני יתקבל תוך  -)הוסבר קודם(  MITREטופס אינטרנט של  .1

2. Google Form  שלDWF  )ית איטי אך פשוטתהליך יחס -)ראו לינק קודם 

 CNA-שליחת מייל ישירות ל .3
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תתבצע במספר מועט של מקרים, משום שלרוב יהיה מדובר על אותה  CNA-שליחת מייל ישירות ל

בעצמה. עם זאת, במידה ונאלצתם  CVE-החברה שדיווחתם לה על החולשה, ואז היא כבר תנפיק את ה

, ולרשום במייל את כל MITREאינטרנטי של לשלוח מייל, ההמלצה שלי היא לפתוח במקביל את הטופס ה

 סעיף כמו בטופס. בצורה זו תהיו בטוחים שלא פספסתם שום פרט.-אחר-הפרטים הטכניים, סעיף

 CNAאני חלק מקבוצת מחקר, והמעסיק הוא 

 .Go Figureיותר,  מורכבבאופן מפתיע, התהליך במקרה הזה יהיה 

ים. גש אל -CVEאומר ש)בתקווה( יש לה בלוק מוכן של , זה CNAהיות והחברה שאתה עובד בה היא כבר 

האחראי על ניהול הבלוק בחברה שלכם, ותבקש ממנו שיקצה לך מזהה. באחריותו לדאוג לרישום כך 

 שלא יהיו כפילויות פנימיות אצלכם בחברה.

ובחרו , MITREבמידה ולחברה שלכם עוד אין בלוק מוכן, או שהוא התמלא, גשו אל הטופס האינטרנט של 

 .”Request a block of IDs (For CNAs Only)“הפעם באופציה: 

 ידעו מה פרטי החולשה? MITREאז מתי 

 CNA (“Request an update-ישנה אופציה לדווח להם על חולשה שהונפקה על ידי ה MITREבטופס של 

to an existing CVE Entry”:אופציה זו מתפקדת בשתי צורות .) 

 פרטי החולשה יעודכנו -או שכבר התפרסמה  MITREידי  חולשה שהונפקה על .1

והם לא ידעו מה  MITREהחולשה תרשם על ידי  -וטרם פורסמה  CNAחולשה שהוקצתה לבלוק של  .2

 לעשות איתה...

כן, קראתם נכון. מסיבה שעוד לא הבנתי, במקרה הזה, למרות שמילאתם את כל הפרטים בטופס 

יל שמבקש מכם להגיש שוב את הפרטים המלאים של החולשה מי MITRE-האינטרנטי, אתם תקבלו מ

ושולח אותן בגוף  "flat file"-(. אני לרוב מגיש את החולשות ככאןבאחת מהצורות הנתמכות )ראו רשימה 

 המייל.

לא יהיו הפניות חיצוניות )בלוג שמסביר על החולשה, לינק  MITRE-אם בפרטים שתשלחו ל :#1לכוד מ

לרשום את החולשה, כי אין לה  יסרבולהודעה של המפתח / יצרן בנוגע לחולשה או לתיקון שלה(, הם 

 ראיות חיצוניות. וזה מתקשר למלכוד הבא.

את הפרטים תוך  יפרסמוהיו בעיות, הם ככל הנראה  קיבלו את הפרטים ולא MITRE-במידה ו #:2מלכוד 

שבועיים ממועד קבלתם. כן, גם אם כתבתם במפורש שלא יפרסמו כי אתם מסנכרנים הרבה -שבוע

 חולשות בין מספר גופי פיתוח, לצורך פרסום מחקר גדול.

דווח להם על מתייחסים לדיווח שלכם כאל אישור לפרסום, ולכן רצוי ל MITREבשורה התחתונה,  מסקנה:

 ההקצאה שביצעתם מהבלוק שלכם רק לקראת הפרסום המתוכנן.

https://cve.mitre.org/cve/list_rules_and_guidance/cve_assignment_information_format.html
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 שנמלא? CVE-אז מה הפרטים שמופיעים ב

)שלדעתי הוא הנוח ביותר(, ואנסה להסביר כל  MITREלצורך ההסבר אני אעבור על הטופס הפומבי של 

 סעיף שרלבנטי לחולשה עצמה )ולא שם היצרן, גרסא או האם היצרן אישר(:

 (Vulnerability Type) חולשה סוג .1

a. ולא של המשמעות שלה כלפי המוצר הפגיע( חולשהזהו הסיווג הטכני של ה( 

b. MITRE מציעים ממש מעט אופציות, וזה די עצוב. אני לרוב בוחר ב-“Other or unknown”  ורושם

 את הסוג המתאים בשדה החדש שמתווסף לטופס.

c.  בפורמט“flat file”  השדה יקרא“Problem Type”  ואז לרוב אחפשCWE  מתאים שיתאר את

 (כאןהחולשה )ראו רשימה מלאה 
 

 (Impact) החולשה משמעות .2

a. ?מה תוקף יוכל להשיג בהינתן החולשה 
 

 (Affected Components) פגיעים/  מושפעים רכיבים .3

a. ?מה הרכיב הפגיע במוצר 

b. גנון שאתם תוקפים?איזה מנגנון במוצר הוא המנ 
 

 (Attack vectors) תקיפה וקטור .4

a. )'דרך איזה ממשק אתם תוקפים את המוצר? )רשת, קריאה מקובץ, וכו 
 

 (Suggested description) טכני לתיאור המלצה .5

a. במידה והתיאור שלכם מנוסח נכון, הוא ישאר כמעט כמו שהוא 

b.  לפעמיםMITRE  לי יעשו איזה שינוי קוסמטי )למשל: הם שינוlong packet field ל-long string ,

 אפילו שהשדה המדובר בהודעה לא היה מחרוזת...(

c. :תנסו להסתכל על מזהים מפורטים של חולשות ולנסח כמו שהם ניסחו. לדוגמא 

"FreeRDP prior to version 2.0.0-rc4 contains an Integer Truncation that leads to a Heap-Based Buffer 

Overflow in function update_read_bitmap_update() and results in a memory corruption and probably 

even a remote code execution". 

d. אחרי ניסוח אחד מוצלח, פשוט תחזרו אליו בכל פעם ותנסחו שוב כמוהו 

e. :לא אל תתהדרו במשמעות שלא הצלחתם להדגים בפועל. רצוי לכתוב "הרצת קוד" ל חשוב

מילות סייג, רק כאשר הצלחתם להדגים אחת. אחרת, תחליטו מה לדעתכם הסיכוי להשמשה 

 מוצלחת, ותסייגו בהתאם:

i. “probably” - אפשר ולא הדגמתי 

ii. “possibly” - יהיה קשה להדגים 
 

 (Discoverers) קרדיט .6

a. באסה, נכון? -יופיע בפרסום הסופי  לאזה השדה היחידי ש 
 

 (references) חיצוניות הפניות .7

https://cwe.mitre.org/
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a. :)לינקים לכל דבר שימושי )אפשר להשאיר ריק בנתיים 

i. Release notes של היצרן שמודיע על התיקון 

ii. Git commit שמתאר את התיקון 

iii. Blog post שלכם שמתאר את המחקר שעשיתם 

בסיכוי סביר, בזמן מילוי הטופס לא יהיו לכם הפניות חיצוניות. הפניות אלה יתווספו כאשר תרצו לפרסם 

תהיה פומבית  לא( וreservedהחולשה ולהודיע עליה לעולם. כרגע, החולשה תופיע כ"שמורה" )את 

 לציבור.

 Public Disclosure -פרסום החולשה 

 אופציות: 3אז תהליך התיקונים הסתיים סוף סוף, והגיע הזמן לפרסם את המחקר שלכם. לשם כך יש 

 בתיאום איתכם וכנראה תפרסם אותו בעצמה או CVE-החברה רשמה את ה .1

 שבועיים לפני הפרסום הרצוי -את הפרטים כשבוע  MITRE-תשלחו ל - CNA-אתם עובדים ב .2

 מיד אחרי הפרסום MITREאחרת, נמלא את הטופס האחרון של  .3

"( ובו נוכל Notify CVE about a publicationהוא כאשר בוחרים באופציה )" MITREהטופס האחרון של 

 ות שנרצה להוסיף על אלה שרשמנו קודם.לציין את רשימת כל ההפני

 שלכם או הודעה של היצרן. blog postאין אפשרות לפרסם ללא הפניה למקור הפרסום:  חשוב:

מתפרסם, הקפידו להוסיף הפנייה חיצונית לבלוג שלכם בו  CVE-מכיוון ואין שדה "קרדיט" לאחר שה טיפ:

אלייכם, ותופתעו לגלות שלא מעט אנשים יכנסו תכתבו על החולשה שמצאתם. בצורה זו החולשה תשוייך 

 לקרוא את הבלוג שכתבתם בזכות ההפניות הללו.

 עדכון פרטים / סגירת קצוות

שפורסם. בשביל העדכון כנראה  CVE-ולמלא "עדכון פרטים" ל MITREבמידת הצורך, ניתן לחזור אל 

החולשה שדווחה. עדכון לרוב  , או למחקר שמצא אתCVE-שתצטרכו להוכיח זיקה לפרסום המקורי של ה

 יתבצע במקרים הבאים:

 Blogלפרסום לפני שיצא  MITRE-כקבוצת מחקר, את הפרטים שלחתם ל -הוספת הפניות חיצוניות  .1

postזה הזמן להוסיף הפנייה אליו , 

 קורה מדי פעם, יחסית נדיר -תיקון שגיאות  .2
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 התוצר הסופי

משלכם, הוא מפנה למחקר פומבי שלכם )אחרת לא תקבלו  CVEסיימתם את כל התהליך, ועכשיו יש לכם 

 קרדיט לחולשה( והוא פומבי כך שכל העולם יכול לראות אותו, מזל טוב 

, והוא יכלול את NVD-אז איך יראה הפרסום, ואיזה פרטים הוא כולל? הפרסום הרחב ביותר יהיה ב

 הפרטים הבאים:

 שדה הטקסט שכתבתם -תיאור החולשה  .1

רשימת הלינקים שלכם ועוד מיליון לינקים לא מועילים שמתווספים עם הזמן  -וניות הפניות חיצ .2

 ומתאמים בין יותר מדי אתרים שכל אחד מפרסם העתק משלו של מאגר החולשות הפומבי

 CVSS 3.0מפרט טכני של החולשה, לרוב במבנה  .3

CVSS מה? 

CVSS 3.0 ט הפרטים הטכניים של החולשה. הוא התקן העדכני )בטח ישתנה שוב בזמן הקרוב( לפירו

מדובר על אוסף שאלות שמגדירות יחד את הסיכון שגלום בחולשה, ובהתאם ינתן לה ניקוד )רציונאלי, אך 

, 10. התקשורת לפעמים מתלהבת כשמדווחות חולשות עם ניקוד מושלם של 10-ל 0לאו דווקא שלם( בין 

שות הוא ברמה די ירודה, ולא תואם בפועל למרות שהנסיון שלי עד כה מראה שהסיווג שמתבצע לחול

 למורכבות הניצול / רמת הסיכון שהחולשה משקפת למערכת בסיטואציה אמיתית.

, המחשבון גם מוסיף הסבר בנוגע לכל אחד כאןמחשבון מועיל לחישוב הניקוד של חולשה ניתן למצוא 

 יטריונים, כולל דוגמאות די טובות לכל סעיף.מהקר

 אז מה הקריטריונים וממה הם מורכבים?

 רשתי )אינטרנט(, קרבה )רשת מקומית(, מקומי )לרוב קריאה מקובץ(, גישה פיסית. וקטור תקיפה: .1

פשוטה / מורכבת. תקיפה תהיה מורכבת במידה והיא הסתברותית ו/או תלויה  מורכבות התקיפה: .2

א בשליטתו של התוקף ושעלולים להקשות על הניצול. תקיפה יכולה להחשב "פשוטה" במרכיבים של

 גם אם היא דורשת מחוקר להיות מנוסה מאוד בעולם השמשת החולשות.

 למשל( adminכלום, מעט )הרשאות חלשות ובסיסיות(, חזקות )הרשאות  הרשאות נדרשות: .3

 ודד של החלטה, אין כאן סקאלה.נדרשת / לא נדרשת. מדובר בביט ב אינטראקצית משתמש: .4

 השתנה / לא השתנה. האם תקיפה מוצלחת משפיעה גם על רכיבים מלבד זה שנתקף?הקשר:  .5

 אין, מועטה, גבוהה.פגיעה בסודיות:  .6

 אין, מועטה, גבוהה.פגיעה בשלמות:  .7

 אין, מועטה, גבוהה. פגיעה בזמינות: .8

שמנפיק את  CNA-לעיתים נקבעים על ידי ה בעצמה, אך MITREקריטריונים אלה לרוב מחושבים על ידי 

 החולשה )דבר שמאפשר לו להפחית מעט בנזק כדי להמנע מרעש תקשורתי פוטנציאלי(.

https://www.first.org/cvss/calculator/3.0
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 סיכום

( הוא טכני בעיקרו, ומשתנה בהתאם לגוף / מוצר בו נמצאה CVE-IDתהליך הנפקת מזהה חולשה )

סיבה לפחד מהתהליך. אני מקווה  החולשה. רוב שרשרת הטיפול ברישום מורכבת מפקידים, ולכן אין

 שהמדריך העביר בצורה טובה את הפרטים ואני מקווה שתמצאו אותו מועיל.

 

 הערת המחבר

מועיל כאשר באים לתקוף מערכת )לצרכי  לאים, ורובם המוחלט -CVEבשנים האחרונות מונפקים המון 

שות אמיתיות ומועילות, והמנעו מחקר כמובן(. אנא הקפידו כי החולשות שאתם מדווחים עליהן יהיו חול

 אוכל שלא חולשה על לדווח לאשמהגזמה בחשיבות / תיאור החולשה. כלל האצבע שלי הוא שאשתדל 

 . בפועל בה להשתמש

 

 על המחבר

-. עוסק בעיקר בתחומי הCheck Pointחוקר אבטחת מידע בקבוצת המחקר של חברת  אייל איטקין:

Embedded אותיות ) 3-וטוקולי רשת ששמם מורכב רק מוהתקשורת, בד"כ שבירת פרFAX ,I2P ,PTP ,

RDP  וכו'(. מפעם לפעם עוסק בציד חולשות בפרויקטיBug bounty :ברשימה הכוללת את ,Microsoft 

(C)Python, (C)Ruby, MRuby  PHP, Perl .ועוד , 

 אבטחה בלוג: itkin.wordpress.comhttps://eyal 

 אימייל: eyal.itkin@hotmail.com 

 Twitter: @EyalItkin 

 

  

https://eyalitkin.wordpress.com/
mailto:eyal.itkin@hotmail.com
https://twitter.com/EyalItkin
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 Ring Doorbell-זיוף שידור של ה

 אור צינגיסרמאת 

 

 הקדמה

 27-. בIoTרד את מרבית יומי אני מבלה בחיפוש אחר חולשות מטעם עבודתי כחוקר אבטחה בדוג'ו בולגא

את הפריצה שלנו לשידור  Mobile World Congress Barcelona 2019-לפברואר הדגמנו על הבמה ב

, אשר זכתה לסיקור תקשורתי רחב היקף. לצד ההדגמה החיה המוצלחת Amazonהאינטרקום החכם של 

אודות המתקפה. מאמר זה הינו ברובו תרגום הפוסט וכן מרחיב פרסמנו כתבה בבלוג החברה בה פירטנו 

בנושא השמשת ההתקפה, אשר מאפשרת האזנת סתר לשידור וידאו ושמע מהאינטרקום וכן הזרקה של 

פקטות אלו כרצוננו. דרישת הקדם היחידה לביצוע המתקפה היא להיות עם רגל באותה הרשת כמו 

 הטלפון בו האפליקציה מותקנת.

כמו מצלמות  IoTהיא חברת בת של אמזון ועוסקת במוצרי  Ringהקדמה על המוצר המדובר: נתחיל ב

מקובע מחוץ לבית ומחליף את הפעמון הקלאסי.  Ring Doorbell-פנים, אינטרקומים, תאורה חכמה ועוד. ה

מזמזם בפעמון. המשתמש יכול  ומקבל התראה כאשר מישהו Ringהמשתמש מתקין את אפלקציית 

ואם יבחר לענות, יוכל לדבר עם מי שמחוץ לדלת דרך הרמקול  Doorbell-לראות ולשמוע את השידור מה

, ניתן לפתוח את הדלת Amazon Keyהמובנה. בהנחה שמותקנת גם מערכת מנעול חכם כדוגמת 

 של אמזון.באמצעות האפליקציה הרלוונטית, למשל בשביל לפתוח למנקה או לשליח 

 

-כפי שראוי לעשות, התחלנו את המחקר על ידי סריקת ידיעות ופרסומים קודמים אודות המוצר. אכן, ב

 WiFi-גניבה של פרטי ה Doorbell-נמצאה חולשה שמאפשרת על ידי לחיצה על כפתור ההתקנה ב 2015

ה חברת הצ'יפים שמציע SDK-, בשאריות מהIoT-של הבית. הבעיה הייתה כפי שקורה רבות בעולם ה

https://ring.com/
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פותח במצב התקנה אפשר לגשת  Doorbell-שה WiFiשבשימוש. דרך הרשת  SoC-המייצרת את ה

מהרה לבצע עידכון תוכנה על  Ring-. שווה להזכיר ש-WiFiלעמודי אדמיניסטרציה אשר כוללים את פרטי ה

 שהוקצה.  Disclosureכלל המכשירים בתוך החלון 

 

 מבוא לתעבורת זמן אמת

הבין כיצד ממומשת המצלמה נתחיל בהסבר קצר על איך עובדת תשדורת זמן אמת: כאשר יש כדי ל

 SIPטריגר, בדרך כלל פיזי על ידי חיוג או זמזום, נשלחת הודעת הקמת שיחה בפרוטוקול הנקרא 

(Session Initiation Protocol ההודעה, שעוברת מעל .)UDP מזהה  -, מעבירה מספר פרטים חשובים

, פורט פנוי שישמש להעברת התוכן ועוד. לאחר stream-והמחויג, מזהה השיחה, סוג קידוד ההמחייג 

להבהיר שהוא בתהליך עיבוד הבקשה,  SIP TRYING, המחויג שולח הודעת INVITEהודעה זו שנקראת 

 Data-שמסמן שהערוץ מוכן, בו כתוב הפורט אליו יש לגשת. על מנת לפתוח את פורט ה SIP OKולבסוף 

אשר מפעילה הפניה  STUN (Session Traversal Utilities for NAT)השירות מוציא פקטת  NATסביבת ב

על גבי  Dataוניתן להתחיל לשלוח הודעות  TCP-סופי בדומה ל ACKשל פורט מסוים. לאחר מכן נשלח 

יה אחת הוא פרוטוקול ורסטילי שתומך במספר משתמשים מאחורי מרכז SIP-הפורטים שנפתחו. נציין ש

 Real Time)קיצור של  RTP-יחיד( וכן בניתוב דרך פרוקסים בדרך. בשלב זה משתמשים ב IP )ריבוב מעל

Transport Protocolבשביל להעביר את ה )-Codec  שיטת קידוד השמע / וידאו( שנבחר, פרוטוקול(

 וריבוב מקורות שונים. Sequencing-התומך ב
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 ניתוח פעילות רשת

וכיצד  Doorbell-סודות התקשורת זמן אמת, נתמקד כעת על תעבורת הרשת שמתרחשת בלאחר הבנת יי

 AWS (Amazon Web-בחרה היא להשתמש ב Ring-השידור מגיע לאפליקציה. הארכיטקטורת תקשורת ש

Services כשרתי תמסורת. האפליקציה והמכשיר משדרים לענן ומקבלים ממנו את השידור של המקביל )

לאפליקציה. האפליקציה  notificationלענן, אשר שולח  RESTעמון נלחץ ונשלחת בקשת להם. תחילה הפ

עושה  Doorbell-לשרת, כל אחד עם פורטים מוקצים משלו. ה SIP INVITEשולחים במקביל  Doorbell-וה

 הוסיפו:  Ring-מיוחדים ש headersעם  SIP-זאת ב

 

 [לענן Doorbell-מה SIP הודעת]

, שדות שמרחיבים את הפרוטוקול X-SESSION-HASH-ו X-SSRC-A ,X-SSRC-V-מוש בבתמונה רואים שי

מקור   IPהוסיפה. ככל הנראה מדובר בחתימה על הפרמטרים של השיחה )פורט מקור ויעד,  Ringאשר 

 RTP-ויעד, מזהה שיחה( כדי שלא יהיה ניתן לשנותם, וכן מפתח ההצפנה שמשמש בשביל העברת ה

יש ווריאנט  RTP-, ולTLSמאובטח היא מעל  SIPציין רק שהשיטה הסטנדרטית להעביר שבאה לאחר מכן. נ

 בשביל שידור מאובטח. SRTPבשם 

 שעוברת: RTP-אינו יודע לפענח את תעבורת ה Wireshark-לאחר הקמת השיחה ניתן לראות ש
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העתידיים,  dissectors-ל SIP-פורט שהוצהרו בשלב ה-התוכנה חכמה מספיק להשליך את הצימודי קידוד

( MP4)בשימוש ב H264של  codecאבל אפשר לראות שהתעבורה לא נראית הגיונית. הפירוק בעזרת 

ועוד מכיוון שהשכבה השביעית  Unknown Subtype, Bad NAL Length, Reservedזורק שגיאות של 

א הייתה לנו גישה ול SIP-מוצפנת. לא הצלחנו לפענח את ההצפנה בעזרת הפרמטרים המיוחדים שעברו ב

 על מנת להבין כיצד היא מתבצעת. Firmware-ל

 SIP-בשלב זה עברנו להסניף את האפליקציה. לצערנו ראינו שהתעבורת התראות, עדכונים, נתונים ו

, כך שלא ניתן לראות את הקמת השיחה ישירות )אפשר בעזרת שיטות הסנפה Ringמוצפנת לשרת של 

כאן(. למרות זאת, אחרי שמצלצלים ורואים את השידור של המצלמה  scope-יותר מתקדמות שמעבר ל

 :plain-ב RTPאפשר לראות את התוכן 

 

ולכן רצינו לראות אם אפשר לשחזר מהן את  H264מבין כהגיוניות בפורמט  Wireshark-אלו פקטות ש

והצלחנו לראות , pcap, שמחלץ סרטונים / שיחות מתוך קובץ videosnarfהסרטון. השתמשנו בכלי בשם 

(! המשמעות היא שכל מי שיכול לשים את ידו G711( ולשמוע מהמיקרופון )H264את הסרטון מהמצלמה )

  על הפקטות של האפליקציה יכול לראות את השידור. התמונה התבהרה ונראית כך:
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שת אז איך נוכל לצפות בשידור? בתור התחלה יש להיות ברשת משותפת עם הטלפון. אפשר להיות בר

Wi-Fi  ציבורית משותפת כמו ברכבת או בבית קפה, להריםAP  זדוני שהטלפון ייצטרף אליו או להשתמש

בין הנתב והטלפון ומתחזים להם  ARP. לאחר מכן, מבצעים מתקפת pivotingבמכשיר ביתי פרוץ בשביל 

התרחיש בשכבה שתיים. כעת נקבל את התעבורה המקורית ונוכל להעביר אותה הלאה גם לטלפון. 

 תקיפה ייראה כך:

 

 ומריצים: Kaliמרימים 

1. Arpspoof - מרעילים את הrouter ואת הטלפון כפי שהוסבר 

2. Rtpdump -  כלי לכתיבת תעבורתRTP מפורט לקובץ, אותו ניתן לקרוא 

3. Iptables - שימוש ב-target  בשםTEE  127.0.0.1לשכפל את התעבורה ליעד 

 לנתב כדי להעביר את הפקטות ליעדם האמיתי על ידי: כמובן שצריך להפוך את המחשב שלנו

echo 1 > /proc/sys/net/ipv4/ip_forward 

זה יש לנו יכולת מרשימה של האזנת סתר לדלת כניסה של אנשים, בעזרתה ניתן לעשות  setupבעזרת 

הוא  הנדסה חברתית ולאסוף פרטים מעניינים רבים אודות ההרגלים בבית הקורבן. השלב הבא המתבקש

 לזייף תעבורה:
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 שני שינויים על מנת לעבור למצב התקפה:

1. Iptables - הופכים את חוקי ה-TEE  ממקודם לחוקיDROP ובכך מפילים תעבורת שמע ווידאו 

2. Rtpsend - משדרים את קבצי ה-RTP ששמרנו בשלב הקודם לעבר הקורבן 

את הקורבן לפתוח את הדלת מרחוק  בסיסית. בעזרתה, עשויים לשכנע replayבכך אנו משלימים התקפת 

למי שהוא חושב שמכיר ושהוא סומך עליו. ההשלכות יכולות לנוע בסקלה שבין מתיחה מצחיקה לבין 

 אירועים נוראיים כמו חטיפת ילדים שההורה שלהם פתח מרחוק למי שנראתה כמו הבייביסיטר.

 

 דיווח וסגירת החולשה

 באנדרויד הבעיה תוקנה.  3.4.7ובגרסה  Ringהחולשה דווחה לחברת 

 

 סיכום

התקיפה שהוצגה במאמר זה מראה שגם בחברות הענק ובמוצרי דגל ניתן למצוא חולשות לוגיות חמורות 

 TLS-שדרוש מעט מאוד ידע ומיומנות לנצלן. ניכר שנעשה מאמץ לאבטח את השידור בעזרת שכבת ה

מוצפן. למרות זאת, מערך ההגנה חזק ה RTP-מהמכשיר כמו גם ה SIP-באפליקציה והשדות המיוחדים ב

לטלפון. אירוני שדווקא מוצר אבטחה  RTPרק כחוזק החולייה החלשה שלו, שבמקרה זה הייתה התעבורת 

שאמור לחזק את תחושת הביטחון פותח הזדמנויות תקיפה חדשות שלא היו קודם, וזהו מוטיב שחוזר על 

 עצמו שוב ושוב בעולם האבטחת מידע.

 

 מקורות

 תתמונ Ring Doorbell: 

https://target.scene7.com/is/image/Target/GUEST_6ae6702b-c0b5-427b-8b74-

cf2761aaca3b?wid=488&hei=488&fmt=pjpeg 

  

https://target.scene7.com/is/image/Target/GUEST_6ae6702b-c0b5-427b-8b74-cf2761aaca3b?wid=488&hei=488&fmt=pjpeg
https://target.scene7.com/is/image/Target/GUEST_6ae6702b-c0b5-427b-8b74-cf2761aaca3b?wid=488&hei=488&fmt=pjpeg
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  OT-מבוא למערכות בקרה בעולם ה

 גלעד זינגרמאת 

 

 הקדמה

, אזורים פיננסיים, הגנה על ITאנו רגילים לשמוע בכל מקום על אבטחת מידע וסייבר במערכות מידע, 

אתרי אינטרנט, בסיסי נתונים הגנה על פרטיות וכד'. בנוסף, המילים: נתב, חומת אש ואפילו סוגי התקפות 

 , הפכו להיות שגרת השיח היומיומית בתקשורת.ןעת שרות, רוגלות ורושעות למיניהעל מערכות כגון מני

ומתוך  CIA - Confidentiality Integrity Availability-אבטחת מידע "קלאסית" מושתתת לרוב על מודל ה

כך מרבית הנכסים עליהם נרצה להגן יהיו נכסי מידע )מוחשיים ולא מוחשיים( אשר הפגיעה בהם תוכל 

 ייצר פגיעה בסודיות המידע, מהימנותו וזמינותו למשתמש.ל

 ?OTבשם  IT-הידעתם שיש יקום מקביל ל

OT - Operation Technology - בו עולם הנכסים טיפה משתנה. מדובר ביקום בו חיים בקרים  םהינו התחו

מהלך  מתוכנתים, עמדות מהנדס ותפעול, שרתי סקאדה והמון הפתעות אשר למעשה משפיעות על כל

 . IT-בחיי היום יום שלנו לא פחות מעולם ה

שכן מדובר בתהליכים ופחות במידע. תהליכים בהם  AIC-טיפה משתנה ונהפך ל CIA-ביקום זה עולם ה

נרצה ראשית זמינות )לסגור את המשאבה מיד(, מהימנות )מה הטמפרטורה האמיתית של מיכל 

 תהליך העבודה של הבקר.אמוניה?( ולבסוף סודיות שכן לא נרצה לחשוף את 

, פרוט אשר יאפשר OT-מאמר זה הינו ראשון מתוך סדרת מאמרים בה אפרט על הקווים לדמות עולם ה

כגון עולם  OT-ישן זה. במאמרים הבאים נצלול לתחומי משנה בעולם ה-לכם הצצה קלה לעולם חדש

חבר את נושא ההגנה בסייבר בכל (, עולם הספנות וכמובן נIndustry 4.0הבנייה )בנייה חכמה(, מפעלים )

 אחד מהתחומים.

 קריאה מהנה!
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  ICS-מבוא ל

 נתחיל בקצת ראשי תיבות:

 OT - Operation Technology 

 ICS - Industrial Control Systems 

 Scada - Supervisory Control and Data Acquisition 

 DCS - Distributed Control System 

 ום מתייחסים למערכות הללו לרוב בשם מערכות סקאדה. וכך היא נראת בכלליות:כיום אנשי מקצוע בתח

 

 מרכיבי המערכת )ארכז את המרכיבים המרכזיים בתחום(:

 מפעילים/סנסורים/חיישנים: 

מאפשרים את החיבור בין עולם הבקרה לעולם הפיסי. חיישן יכול להיות לדוג' מדיד טמפרטורה 

בזמן אמת טמפ' בחדר ומעבירה לרכיב הבא בשרשרת )בקר(. מפעיל אנלוגי או דיגיטלי אשר דוגם 

יכול להיות מנוע חשמלי או משאבה אשר מבצעת פעולה בהינתן פקודה )מהבקר...נכון(. החיישן לרוב 

 ( אשר יפעיל או יפסיק את פעולתו.1/0יעביר מידע לבקר והמפעיל בדיוק להיפך, יקבל מידע )

 PLC - Programmable Logic Controller - בקר: 

 ( של מידע בינארי )לרוב(. קיימים כרטיסי הרחבהInputs/Outputsמחשב זעיר בעל כניסות ויציאות )

 לבקרים כולל עבודה רשתית ללא כניסה ויציאות ומגוון רחב של אפשרויות עליהם לא נדון בשלב זה.

 ת מפעיל בשגרה.הבקר יתוכנת לרוב בלוגיקה קבועה מראש, אשר תאפשר פעילות ללא התערבו

הבקר יבנה לרוב מחומר עמיד וקשיח שכן קיימים מקרים בהם תידרש עמידות לטמפרטורות לא 

 שגרתיות ולתנאים סביבתיים קשים.
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 דיאגרמת" הינה הבקר של התכנות משפות אחת .ושינוי לעדכון ניתנים אשר וחומרה תוכנה לבקר

 :הבא בתרשים ותלרא שנוכל כפי הבקר פעולת את המדמה שפה", סולם

 

 יעצור בו מסוים לאזור חבילה הגעת בהינתן במפעל מסוע הפעלת :בבקר שתיצרב ללוגיקה דוגמא

 כך על שמצביע סנסור(, (INPUT שמקבל מסוע? כאן לנו היה מה] ותיסגר תסומן והחבילה המסוע

 ([.INPUT) המסוע עצירת(, OUTPUT) למקומה הגיע שהחבילה

 HMI - Human Machine Interface  /Engineering Station 

העסקי  FLOW-עמדת שליטה ובקרה על הבקר, כתלות בהרשאות וסוג העמדה, היא תאפשר צפייה ב

של המערכת )מה מחובר למה תהליכית(, צפייה בסנסור )לדוג' מהי הטמפרטורה, מה מפלס המים 

נויים בבקר עצמו ואף לשנות וכד'(. בעמדות המוגדרות עמדות מהנדס או פיקוח, יהיה ניתן לבצע שי

 את לוגיקת ההפעלה מרחוק או לבצע הפעלה או הפסקה ידנית של תהליכים.

לדוגמא, מקרה בו קיימת תקלה בבקר ועל המהנדס לבצע מעקף של פעילות קריטית בתהליך, תינתן 

 האפשרות לבצע התערבות בתהליך בצורה ידנית ולכבות/להדליק רכיב פיזי מרחוק )למשל משאיבת

מותקנות עם מערכות הפעלה מסוג חלונות )גם כאלו שלא  HMIמים(. לרוב נוכל לראות עמודת 

נתמכות כבר, עליהן נדבר בהמשך(, כמו כן לעיתים ישלבו תחנות אלו אמצעי תקשורת נוספים מלבד 

 רשת רגילה )חיבורי רדיו, חיבורי סריאליים וכד'(.

 Data Historian - היסטוריין  

. הפעלת רכיב, קבלת OT-למעשה בסיס נתונים האוגר כל פעילות המתרחשת ברשת הרכיב זה הינו 

חיווי מסנסור, טעינת קוד לבקר, עדכונים וכל פעולה אחרת, תנוטר ותועבר לשרת ההיסטוריין, משם 

( לטובת אגרגרציה וקורלציה SOCאו למרכז שליטה ובקרה ) SIEMכקובץ לוג למערכת  חתוכל להישל

אבטחת מידע  יים על מנת לאתר בעיות תפעוליות, ניתוח אוחר וכמובן איתור אירועעם נתונים אחר

 ברשת.
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 אז כיצד כל היופי מתחבר לרשת?

 רשת עסקית/מנהלתית ורשת תפעולית: -פה נבצע הפרדה בין שני מושגים בתחום 

. ברשת זו ( הינה הרשת בה מתנהל הארגון, בין אם זה מפעל מזון או תחנת כוחIT) המנהלתית הרשת

, חיבור לדומיין מרכזי וכמובן לרוב חיבור ERPנוכל למצוא את שרת הדוא"ל, שרת הקבצים, מערכות 

 לאינטרנט!

( כשמה כן היא, משמשת לתפעול התהליכים, בין אם מדובר בתהליכי ייצור תרופה OT) התפעולית הרשת

קצה כל פעילות כזו יושב בקר בפס ייצור, תהליך הזרמת שפכים או העברת מים אליכם לברז בבית, ב

 כן או לא.  -אשר מחליט 

 

 גם כאן נעשה שימוש בפרוטוקולי תקשורת רבים ומגוונים. IT-כמו בעולם ה

למערכות או תעשיות ספציפיות, חלקם פרי פיתוח של יצרן וניתנים לשימוש רק במערכותיו  םחלקם ייעודיי

  וחלקם נפוצים במרבית המערכות הקיימות כיום.
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 םהינם רשימה חלקית ומצומצמת מאוד של פרוטוקולי DNP ,PROFIBUS ,IEC 61850 ,BACNETשמות כגון 

 .הבשימוש התעשיי

אשר הוסב  1979, פרוטוקול סריאלי במקורו משנת MODBUSהנפוצים ביותר הינו  םאחד הפרוטוקולי

 . TCP/IPלעבודה בסביבת תקשורת 

כאשר סוג הפעילות המועבר נקבע ע"ב מספר ידוע מראש , MASTER SLAVEמדובר בפרוטוקול בתצורת 

(Function Code הפרוטוקול מאפשר קריאה וכתיבה לבקר, התעבורה בו אינה מוצפנת ולא נדרשים כל .)

 אמצעי זיהוי ואימות.

וותיק, תחילה העבודה התקשורתית התבצעה ללא תצורת התקשורת המוכרת לכולנו  OT-שעולם ה ןמכיוו

הקיימים על מנת שיוכלו לשלב  םהתפתחות הטכנולוגית נולדו תוספות והרחבות לפרוטוקוליהיום אך עם ה

, הרחבה שאפשרה קישוריות TCP/IP-ולהשתלב בתקשורות מודרניות, אחת מהן הינה ההרחבה לעולם ה

 לעולם החיצוני אבל לא תוכננה לעבודה מאובטחת במקור.

 .OTרים באבטחת תשתיות אז אם באבטחת סייבר עסקינן, כמה מילים על פע

 ?OT/ICSמהם הפערים העיקריים באבטחת מערכות 

  כאמור במערכות  -חיבור בין רשתותOT  אנו צפויים לפגוש לפחות שתי רשתות שונות, רשת תפעולית

ורשת מנהלתית. ברוב המקרים הרשת המנהלתית תחובר לאינטרנט )כמובן עם/בלי אבטחה 

ם קיים קישור ישיר בין הרשת התפעולית לרשת המנהלתית? ייעודית(, אך מה קורה במקרים בה

תארו לכם מצב בו תוקף )ועל כך נרחיב בפרק הבא( "גולש" לבקר אשר אחראי על פעולת משאיבת 

 מים של חברת אספקה, כמה נזק ניתן לייצר באותו רגע? 
 

  את מערכת ההפעלה  קיים ויכוח אינסופי בתעשייה הבקרה, האם לעדכן או לא לעדכן -ניהול עדכונים

או של כל רכיב אחר במערכת שכן עדכון או שינוי של מערכות אשר מחד  HMI -של הבקר, של רכיב ה

שנה ומאידך אחראיות על תהליכים רגישים של ייצור, עשוי לייצר פגיעה או השבתה  20בנות לעיתים 

ת למערכות לא עדכנית כתוצאה מכך נוכל לצפו העלולה לגרום לנזק כספי או אף פגיעה בחיי אדם.

(Un Patched ולעיתים קרובות לפגוש "דינוזאורים" בדמות חלונות )XP  ואף גרסאות ישנות יותר אשר

 אינן נתמכות ופגיעות ביותר.
 

  הזכרתי את פרוטוקול  -פרוטוקולים לא מאובטחיםMODBUS  ככזה שאינו מוצפן בגרסתו הבסיסית

ם המעבירים את התעבורה בצורה גלויה וברורה, ללא מנגנוני והנפוצה, כמוהו קיימים פרוטוקולים רבי

 . IT-הזדהות או אימות משתמשים וללא תמיכה בכל מערך אבטחה כזה או אחר המוכר לנו מעולם ה
 

  איפה אתחיל? בעולם ה -מודעות עובדים-IT  מונהג בארגון המכבד את עצמו, תפקיד שלCISO  אשר

ממעגלי האבטחה הינה האדם עצמו )או העובד( לכן אנו  אחראי על אבטחת המידע בארגון וחלק

רואים תהליכים רבים של העלאת מודעות העובדים לאבטחת מידע בארגונים רבים, גדולים כקטנים. 
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כפי שהזכרתי בפתיח, לנכסי המידע קיימת חשיבות נמוכה יותר בעולם  ?OT-אך מה קורה בעולם ה

מכאן שגם פחות נראה תהליכי מודעות  OT-ון על נכסי האשר אמ CISOזה וברוב הארגונים לא תאתרו 

עובדים או הכרות עם בעיות ההגנה בסייבר בעולם זה. עובדי תפעול אחראים שהתהליך בקצה יעבוד 

שכן כל עצירה של תהליך המפעל הינה אובדן כסף למפעל, האם במקרה כזה תמיד יבצעו חשיבה 

 ר קריטי כדי לשפר את הקליטה שלו? לא חושב...נוספת לפני שלמשל יחברו כרטיס סלולארי לבק
 

 מערכות הבקרה בעולם ה: ניהול מרוחק-OT  מורכבות מאוד ולרוב נמכרות למפעל כמקשה אחת

מהיצרן )או מיותר( כולל חבילת תמיכה מרחוק. תמיכה זו יכולה להתבטא בהשתלטות מרוחקת על 

ף, קיימים ספקים )מחו"ל( אשר לא בקר, עמדת מפעיל או כל רכיב אחר בתהליך המפעלי. בנוס

יאפשרו אחריות על המוצרים ללא פתיחת האפשרות לגישה מרחוקת לרכיבי המפעל בכל עת וללא 

אישור מבעוד מעוד. כמובן שפתיחת גישה מרחוק ללא הגבלה או שליטה, מאפשרת כר רחב 

 הבא(.לאפשרויות תקיפה של מערכת הבקרה דרך "שרשרת האספקה" )עליה יורחב במאמר 
 

 אנו מכירים היטב מעולם מערכות המידע תהליכי  -בקרהSIEM/SOC  המאפשרים ניטור של רכיבי

הרשת ומשתמשיה באופן כמעט הרמטי ומאפשרים קבלת התראות בזמן אמת אודות פרצות 

 Incidentאפשריות, כניסות למערכת או תהליכים לא מורשים ולמעשה מסייעות ביצירת תהליך

Response מקרה של תקיפה או ניסיונות תקיפה והכלתה. בעולם הראוי ב-OT  המצב קצת יותר

מורכב בשל חוסר בשלות )קיימים ניצנים בתחום( הנובע בעיקרו מתפיסה שגויה של "אני מנותק 

מהעולם לכן אני מוגן". בשנים האחרונות אנו מתחילים לראות פתרונות ראויים בשוק אשר יסייעו 

)באתר או באתרים חיצוניים( תוך שמירה על אבטחת המידע  SOCלמוקדי  לחבר את המפעל ותהליכיו

 )חזרנו למידע בדמות לוגי הרישום של המערכת(. 
 

  קיימות מעט מאוד הכשרות בתחום הגנה בסייבר של מערכות  -הכשרותOT  ואלו שקיימות מתקיימות

מכך קשה לאתר גורמים  בחול בלבד ועולות יותר משנה אקדמית )לקורס של חמישה ימים(. כתוצאה

בארץ הניתנים להגדרה כבעלי נסיון בתחום )אני בכוונה נמנע מהמילה "מומחה"( וקיימים מקרים 

, לגורמי האיום והסיכונים הנלווים  IT-בהם ארגונים עשויים לקבל מענה אבטחתי המתאים לעולם ה

 !וכן, הסיכונים שונים לחלוטין - OT-אליו ולא לאלו המתאימים לעולם ה
 

  עולם הבקרה נולד שנים לפני עולם ה -תכנון ללא חשיבה אבטחתית-WEB  המוכר לכולנו. מדובר

בתשתיות ורכיבים אשר לא תוכננו להתחבר לעולם החיצון, בעלי נגישות במערכות סגורות בלבד 

 והחשיבה סביב תכנונן לא כללה היבטי אבטחת מידע או הגנה בסייבר כלל שכן האיומים המוכרים לנו

 היום לא היו מוכרים או לחילופין לא היו רלוונטיים בעת תכנון מערכות הבקרה הוותיקות.
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 סיכום

 להתייחס רגילים אנו אליהן המידע מערכות או הבנק ממערכות פחות לא חיינו את מלוות OT-ה מערכות

ייצור וזיקוק, הם תהליכים תעשייתיים כוללים ייצור, בקרת תהליכים, ייצור חשמל,  .מידע אבטחת בהיבטי

עשויים להיות ציבוריים או פרטיים, והם כוללים טיפול במים והפצה, איסוף וטיפול בשפכים, צינורות נפט 

 וגז, הולכה וחלוקה של חשמל המיוצר בתהליכים ושיטות שונות.

 על ולשלוט לפקח נדרש בהםומערכות מבנה,  מעליותאוניות וספנות,  ואפילו תעופה בשדות מדובר

 יומיומי שימוש נעשה אלו בתעשיות ( וצריכת אנרגיה.HVAC) מערכות אוויר ומיזוג אקלים כותמער

 פגיעה, במוצר פגיעה של שרשרת תגובת לייצר עלולה לפעולתן הפרעה כל אשר קריטיות OT בתשתיות

 האם, תרד המעלית האם המחליט בקצה קטן בקר יש בכולן כמעט. בנפש פגיעה ועד שיבוש, באספקה

 .הכיבוי לכוחות אוטומטי באופן לקרוא ויש שריפה פרצה האם או, לקרר ויש מידי חם

 והסיכונים האיומים, ההגנה נכסי, התהליכים של המורכבות כי להבין כבר יכולים אתם, כאן עד הגעתם אם

 .הרסנית תגובה לייצר עלולה חדירה או טעות וכל IT-ה מעולם לחלוטין שונים, המקרים במרבית, בקצה

 המערכות אבטחת הינו, הבא במאמר בהרחבה אכתוב עליו, OT-ה בתחום המשמעותיים האתגרים חדא

 תקינה עבודה ואפשור קריטיים יצור לתהליכי מינימלית" הפרעה" עם, מראש לכך תוכננו לא שכאמור

 .הרלוונטיים התפקידים לבעלי ורציפה

, לפיכך. הציבור בריאותביטחון ולל חיונית להיות עשויה שלנו המודרנית בתשתית SCADA מערכות אמינות

 בקרת מערכת על שבוצעה, התרחשה כבר כזו תקיפה. להיות קריטיות עשויות אלו מערכות על התקפות

 מערכת התקין שהקבלן לאחר קצר זמן. אוסטרליה, לנד בקווינס שייר י'מארוצ של המועצה של שפכים

SCADA ומערכות צורך שלא פעלו משאבות. יציב לא אופןב לפעול החלו המערכת רכיבי, 2000 בינואר 

. התהום מי של פתוחה ניקוז תעלת וזיהמו סמוך פארק הציפו שפכים. תקין באופן פעלו לא ההתרעה

 אותם לשמור אמורה הייתה המתוכננת הפעולה כאשר פתיחה על ביוב שסתומי כוונו SCADA-ה במערכת

 של תוצאה היו התקלות כי גילה המערכת יומני אחר במעק אך במערכת כבאג נראה זה בתחילה. סגורים

. זוהה שהאשם לפני זדונית חיצונית התערבות של נפרדים מקרים 46 על דיווחו החוקרים. סייבר התקפות

 תקווה תוך, SCADA מערכת את התקין אשר החברה של ממורמר לשעבר עובד ידי על בוצעו ההתקפות

 .הפגועה תהמערכ על להגן כדי שרותיו את שישכרו

 ...זורמים והמים הברז את פותחים שאתם הבאה בפעם למחשבה חומר

 :קשר ליצירת פרטים

http://linkedin.com/in/gilad-zinger  

http://twitter.com/GiladZinger 

  

http://linkedin.com/in/gilad-zinger
http://twitter.com/GiladZinger
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 ברי סיכוםד
 

, אנו מאוד מקווים כי נהנתם מהגליון והכי Digital Whisperשל  105-בזאת אנחנו סוגרים את הגליון ה

למדתם ממנו. כמו בגליונות הקודמים, גם הפעם הושקעו הרבה מחשבה, יצירתיות, עבודה קשה  -חשוב

 ושעות שינה אבודות כדי להביא לכם את הגליון. 

יירים, עורכים ואנשים המעוניינים לעזור ולתרום לגליונות הבאים. אם אנחנו מחפשים כתבים, מא

 צרו קשר!  - Digital Whisperאתם רוצים לעזור לנו ולהשתתף במגזין 

ניתן לשלוח כתבות וכל פניה אחרת דרך עמוד "צור קשר" באתר שלנו, או לשלוח אותן לדואר האלקטרוני 

 .editor@digitalwhisper.co.ilשלנו, בכתובת 

 

 על מנת לקרוא גליונות נוספים, ליצור עימנו קשר ולהצטרף לקהילה שלנו, אנא בקרו באתר המגזין:

www.DigitalWhisper.co.il 
"Talkin' bout a revolution sounds like a whisper" 

 

 .2019בסוף חודש אפריל ון הבא ייצא הגלי

 

 אפיק קסטיאל,         

 ניר אדר,         

         31.03.2019 
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